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IMPORTANT! Before using this product, read and understand the information in the
“Safety” appendix in this document.

Product description

Kit overview

Internal quality
control system for
PCR

Validated DNA
input amounts and
PCR cycles

The Applied Biosystems NGM Detect PCR Amplification Kit is a 6-dye, short
tandem repeat (STR) multiplex assay for the amplification of specific loci in human
genomic DNA.

The kit amplifies:

¢ 16 autosomal STR loci:
— The 12 loci in the extended European Standard Set (ESS): FGA, THO01, vWA,
D351358, D851179, D18551, D21S11, D125391, D1S1656, D25441, D1051248,
and D2251045

— 3 additional loci that are not in the ESS, but that are present in the
AmpF{STR" SGM Plus™ PCR Amplification Kit: D165539, D251338, and
D195433

— SE33, a highly polymorphic locus
¢ Two internal quality control markers (IQCS and IQCL)
¢ 1 insertion/deletion polymorphic marker on the Y chromosome (Y indel)

* Amelogenin (sex determining marker)
The NGM Detect " kit is an Applied Biosystems STR kit that includes an internal
quality control (IQC) system for PCR. The IQC system has two synthetic targets, one
low molecular weight and one high molecular weight, that are amplified with the
sample. The behavior of the IQC target peaks can be used to evaluate the success of
the PCR reaction and give an indication of sample quality.

The kit is validated for use with 500 pg DNA (15-uL input volume) for 30 cycles.

NGM Detect™ PCR Amplification Kit User Guide
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About the primers  The NGM Detect ™ kit primers are manufactured using the same synthesis and
purification improvements as the primers in the GlobalFiler " kit, Identifiler " Plus kit,
and NGM SElect " kit. These improvements enhance the assay signal-to-noise ratio
and simplify the interpretation of results.

The primers that are used in the NGM Detect" kit are unique when compared with
primers for corresponding STR loci in the GlobalFiler ', Identifiler ' Plus, and NGM
SElect” kits except for one D12 primer and one THO1 primer that are shared with the
GlobalFiler " and NGM SElect " kits.

Changes to the IQC Large and THO1 primers

A small number of laboratories reported high background with the original
formulation of the NGM Detect " kit when samples with a high soil burden were run.
After internal investigations, we determined that cross-reactivity of the IQC Large and
THO1 primers with soil-associated microbial DNA caused the background artifact
peaks. Accordingly, we redesigned primers for both markers. We did not make any
other changes to the NGM Detect " kit formulation, protocols, or workflow.

The updated formulation of the NGM Detect " kit was re-validated with internal and
external testing. Other than correcting the soil-associated background issue, the
performance of the updated formulation assay is fully comparable to that of the
original kit. Unless otherwise indicated, the data in Chapter 6, “Experiments and
results” are from the re-validation study.

™

See the Technical Note: Updated NGM Detect ~ PCR Amplification Kit: Validation and
Comparative Study for studies directly related to soil specificity and a direct
comparison of the NGM Detect " kit original formulation to the updated formulation.

D_yes used in the Dye Color Label
kit 6-FAM™ Blue Samples, allelic ladders, and controls
vic™ Green
TED" Yellow
TAZ™ Red
sip™ Purple
Liz"™ Orange GeneScan"-600 LIZ" Size Standard v2.0

NGM Detect™ PCR Amplification Kit User Guide 9
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Loci amplified by the kit
Table 1 NGM Detect™ kit loci and alleles

2 Chapter 1 Product information

] HIEECE Alleles included in Allelic Ladder Dye label e antel
designation location 007
lQCS N/A 1,2 6-FAM™ 2
D251338 2935 11-28 20,23
SE33 6q14 4.2,6.3,8,9, 11-20, 20.2, 21, 21.2, 22.2, 23.2, 17, 25.2
24.2,25.2,26.2,27.2,28.2,29.2,30.2,31.2,
32.2,33.2, 34.2, 35, 35.2, 36-39, 42
lQcL N/A 1,2 2
D165539 16q24.1 5,8-15 vic™ 9,10
D18S51 18¢21.33  |7,9,10,10.2,11-13,13.2, 14, 14.2, 15-27 12,15
THO1 11p15.5 4-9,9.3,10-13, 13.3 7,9.3
D125391 12p13.2 14-19,19.3, 20-27 18,19
D351358 3p21.31 9-20 TED"™ 15,16
FGA 4q28 13-30, 30.2, 31.2, 32.2, 33.2, 42.2, 43.2, 44.2, 45.2, 24, 26
46.2,47.2,48.2,50.2,51.2
Y indel Yq11.221 1,2 TAZ" 2
Amelogenin Xp22.1-22.3, | X, Y X, Y
Y:p11.2
VWA 12p13.31 11-24 14,16
D21511 21q11.2-q21 | 24, 24.2, 25-28, 28.2, 29, 29.2, 30, 30.2, 31, 31.2, 28, 31
32,32.2, 33, 33.2, 34, 34.2, 35, 35.2, 36-38
D151656 1942.2 9-14,14.3, 15, 15.3, 16, 16.3, 17, 17.3, 18, 18.3, 13,16
19.3, 20.3
D2S441 2p14 8-11,11.3, 12-17 14,15
D8S1179 8q24.13 5-19 SID™ 12,13
D195433 19912 6-12,12.2,13,13.2, 14, 14.2,15,15.2, 16, 16.2, 14,15
17,17.2,18.2,19.2
D2251045 22q12.3 7-20 11,16
D1051248 10926.3 8-19 12,15

10
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Standards and For the NGM Detect " kit, the panel of standards needed for PCR amplification, PCR
controls that are product sizing, and genotyping are:
required ¢ DNA Control 007 — A positive control for evaluating the efficiency of the

amplification step and STR genotyping using the NGM Detect = Allelic Ladder.
DNA Control 007 is present in the kit. See “DNA Control 007" on page 13.

* GeneScan "-600 LIZ" Size Standard v2.0—Used for obtaining sizing results.
This standard, which has been evaluated as an internal size standard, yields
precise sizing results for PCR products. Order the GeneScan —600 LIZ" Size
Standard v2.0 (Cat. No. 4408399) separately.

e NGM Detect " Allelic Ladder—Developed for accurate characterization of the
alleles amplified by the kit. The Allelic Ladder is present in the kit and allows
automatic genotyping of most of the reported alleles for the loci in the kit. See
“Allelic ladder profile” on page 11.

Allelic ladder The allelic ladder profile appears on the next page.
profile

NGM Detect™ PCR Amplification Kit User Guide 11
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Figure 2 DNA Control 007 (500 pg) amplified with the NGM Detect” kit and analyzed on an Applied Biosystems "
3500xL Genetic Analyzer (Y-axis scale 0 to 8,000 RFU).
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Contents and storage

The NGM Detect kit (Cat. No. A31832) contains sufficient quantities of the following
reagents to perform 200 amplifications with a 25 pL total reaction volume.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not
in use.

IMPORTANT! Do not refreeze kit components after thawing.

Table 2 NGM Detect™ PCR Amplification Kit (Cat. No. A31832; 200 reactions)

Contents Description Amount Storage

NGM Detect™ Master Mix | Contains enzyme, salts, 2x0.75mL -25°C to -15°C on receipt.
dNTPs, bovine serum
albumin, enzyme, and 0.05%
sodium azide in buffer and

2°C to 8°C after first use, for up to
6 months or up to the expiration
date stated on the kit (whichever

salt comes first).

NGM Detect™ Primer Set | Contains forward and 2x0.25mL -25°C to -15°C on receipt.
reverse primers to amplify 2°C to 8°C after first use, for up to
DNA targets. -

6 months or up to the expiration
date stated on the kit (whichever
comes first).

Store protected from light.

NGM Detect™ Allelic Contains amplified alleles. 1x0.05mL -25°C to -15°C on receipt.

Ladder See “Allelic ladder 2°C to 8°C after first use, up to the
profile” on page 11 for expiration date stated on the kit.
information. Store protected from light.

DNA Control 007 Contains 0.1 ng/pL human 1%x0.3mL -25°C to -15°C on receipt.

male genomic DNA from cell
line in 0.05% sodium azide
and buffer!

See “"DNA Control 007" on
page 13 for information.

2°C to 8°C after first use, up to the
expiration date stated on the kit.

('] DNA Control 007 is included at a concentration that is appropriate for use as an amplification control [that is, to provide confirmation of the
capability of the kit reagents to generate a profile of expected genotype). It is not designed for use as a DNA quantification control. If you quantify
aliquots of DNA Control 007, the concentration may differ from the labeled concentration.

Required materials not supplied

See Appendix B, “Materials required but not supplied”.

14 NGM Detect™ PCR Amplification Kit User Guide
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Instruments and software compatibility

0

Instrument

Validated models
type

Thermal o ProFlex" 96-well PCR System (Cat. No. 4484075)

cyclers o ProFlex™ 2 x 96-well PCR System (Cat. No. 4484076)

o ProFlex" 3 x 32-Well PCR System (Cat. No. 4484073)

o Veriti" 96-Well Thermal Cycler (Cat. No. 4479071)

o GeneAmp" PCR System 9700, 96-Well Silver (Cat. No. N8050001)

o GeneAmp'" PCR System 9700, 96-Well Gold-Plated (Cat. No. 4314878)

IMPORTANT! The NGM Detect™ kit is NOT validated for use with:

« ProFlex" 2 x Flat PCR System (Cat. No. 4484078)

« ProFlex" 2 x 384-well PCR System (Cat. No. 4484077)

- Veriti" 96-Well Fast Thermal Cycler (Cat. No. 4375305)

+ GeneAmp' PCR System 9700 with the aluminium 96-well block (Cat. No. 4314879)

Genetic e 3500/3500xL Genetic Analyzer with any of the following:

analyzers!"] - 3500 Data Collection Software v1 (Windows " Vista operating system) and HID Updater
3500 Data Collection Software v2 (Cat. No. 4480670)

- 3500 Data Collection v2 Software (Windows™ 7 operating system) and HID Updater 3500
Data Collection Software v2 (Cat. No. 4480670)

- 3500 Data Collection v3 Software (Windows " 7 operating system)
e 3130/3130x!Genetic Analyzer with:

- Data Collection Software v4 (Windows™ 7 operating system)

- 3130/3730 Data Collection v4 6-Dye Module v1

Analysis GeneMapper " /D-XSoftware v1.5.2 or later!?!
software

Windows " 7 operating system

[l We conducted validation studies using the 3130x/, 3500, and 3500xL configurations.

2 GeneMapper™ /D-XSoftware v1.2 to v1.5 can be used to analyze NGM Detect™ PCR Amplification Kit data. However, some genotype quality
assessment features of the NGM Detect™ kit are not included in earlier versions of the software. Refer to Chapter 4, “Analyze data with
GeneMapper™ ID-X Software” for more details.

NGM Detect™ PCR Amplification Kit User Guide 15
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Workflow

Extract DNA, see:

www.thermofisher.com/hid-sampleprep
v

Quantify DNA
“DNA quantification” on page 17

v

Perform PCR

“Prepare the amplification kit reactions” on page 19
v
“Perform PCR" on page 21
v

Perform electrophoresis
“Set up the 3500/3500xL instruments for electrophoresis (before first use of the kit)” on page 24 or
“Set up the 3130/3130xl instruments for electrophoresis (before first use of the kit]” on page 28

v
“Prepare samples for electrophoresis (3500 Series and 3130 Series instruments)” on page 27
v

Analyze data
“Set up the GeneMapper" ID-X Software for analysis (before first use of the kit)* on page 35

v

“Create an analysis method” on page 40
v

“Create a size standard definition file if needed” on page 48
v
“Analyze and edit sample files with GeneMapper ID-X Software” on page 50

v

“Examine or edit a project” on page 51
v

Chapter 5, “Assess the PCR reaction with the Internal Quality Control System”

16 NGM Detect™ PCR Amplification Kit User Guide


http://www.thermofisher.com/us/en/home/industrial/forensics/human-identification/forensic-dna-analysis/sample-preparation-extraction.html

\ |
[ /N
N\

N\
’\

/)

\ \/]|
K)
nd
-

B0

2,

Perform PCR

DNA quantification .......... ... ... .. o oo i i 17
Beforeyoubegin ........ ... . . .. 19
Prepare the amplification kit reactions ................. ... ... ... ... ..., 19
Perform PCR .. ... 21
Direct amplification .......... ... ... ... . 22

DNA quantification

Importance of
quantification
before STR
analysis

DNA quantification can be used to determine:

If the sample contains sufficient human DNA and/or human male DNA to
proceed with short tandem repeat (STR) analysis.

The amount of sample to use in STR analysis applications.

The relative quantities of human male and female DNA in a sample (using the
Quantifiler” Trio DNA Quantification Kit). This guides selection of the applicable
STR chemistry.

The DNA quality, with respect to the inhibition level and the DNA degradation
level. This metric is useful for determining the likelihood of recovery of STR loci
with larger amplicon sizes.

If the sample contains highly degraded DNA. Such samples may require an
alternative approach to STR analysis by capillary electrophoresis. Precision ID
NGS System and Panels are optimized for degraded samples. The Precision ID
Identity Panel provides discrimination of individuals similar to STR genotype
match probabilities. Also, the Precision ID Ancestry Panel infers biogeographical
ancestry for investigative leads.

If PCR inhibitors are present in a sample. Such that samples may require
additional purification before proceeding to STR analysis.

EffeCt_ of DNA If too much DNA is added to the PCR reaction, the increased amount of PCR product
quantity on results  that is generated can result in:

Fluorescence intensity that exceeds the linear dynamic range for detection by the
capillary electrophoresis instrument ("off-scale" data).

NGM Detect™ PCR Amplification Kit User Guide 17
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quantifying DNA

& Chapter 2 Perform PCR

Off-scale data are a problem because:

- Quantification (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause a corresponding stutter
peak to appear higher in relative intensity, therefore increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data are not accurate. This inaccuracy
results in poor spectral separation ("pull-up").

* TFalse signals of inhibition by the IQC system, although none is present.
* A reduction in the IQCL peak height.
¢ Incomplete +A nucleotide addition.

To address these problems, rerun the amplification reaction using less DNA.

If too little DNA is added to the PCR reaction, the total number of allele copies added
to the PCR is extremely low. Unbalanced amplification of the alleles may occur
because of stochastic fluctuation.

For information on recent innovations in quantification chemistry, go to
thermofisher.com.

Kit and user guide

Detects

How it works

Quantifiler™ HP DNA

4482911)

For more information, see
Quantifiler” HP and
Quantifiler” Trio DNA
Quantification Kits User
Guide (Pub. No. 4485354)

Quantification Kit (Cat. No.

e Total human DNA
(two targets—one
small amplicon and
one larger amplicon)

e Degraded DNA

Quantifiler" Trio DNA

4482910)

For more information, see
Quantifiler” HP and
Quantifiler” Trio DNA
Quantification Kits User
Guide [Pub. No. 4485354)

Quantification Kit (Cat. No.

e Total human DNA
(two targets—one
small amplicon and
one larger amplicon)

e Human male DNA
e Degraded DNA

Uses 5' nuclease assays with multiple-copy target
loci, for improved detection sensitivity:[”

- The human-specific target loci are multiple
copy, and dispersed on various autosomal
chromosomes.

- The primary quantification targets have
relatively short amplicons (75 to 80 bases), to
improve the detection of degraded DNA
samples.

Uses features that maximize consistency of
quantification:

- Genomic targets have conserved primer- and
probe-binding sites.

- Minimal copy number variation between
different individuals and population groups.

Contains a Large Autosomal target with a longer
amplicon (>200 bases) to help determine if a DNA
sample is degraded.

Contains an Internal PCR control {IPC) 5 nuclease
assay which amplifies an integrated synthetic DNA
sequence. The performance of this assay can be

used to assess whether real-time PCR of the sample
has been impacted by inhibition.

[ The detection sensitivity of the Quantifiler™ HP Kit and the Quantifiler™ Trio Kit is improved over the Quantifiler™ Duo Kit.

18
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Before you begin |

Before you begin

Prepare low-TE
buffer

Thaw reagents
(before first use of
the kit)

For optimal results, we recommend using low-TE buffer for sample preparation.
Prepare it as described in this procedure or buy it from Teknova (Cat. No. T0223).

1. Mix together:
e 10mL of 1 M Tris-HCl, pH 8.0
* 0.2mL of 0.5 M EDTA, pH 8.0

* 990 mL glass-distilled or deionized water

Note: Adjust the volumes accordingly for specific needs.
2. Aliquot, then autoclave the solutions.

3. Store the aliquots at room temperature.

Thaw the Master Mix and Primer Set.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not
in use.

IMPORTANT! Thawing is required only during first use of the kit. After first use,
reagents are stored at 2°C to 8°C and do not require subsequent thawing. Do not
refreeze the reagents.

Prepare the amplification kit reactions

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not
in use.

IMPORTANT! Use adhesive film for plate sealing to provide a consistent seal across
all wells and prevent evaporation. Caps may not provide a consistent seal across all
plate wells.

1. Vortex the Master Mix and Primer Set for 3 seconds. Before opening the tubes,
remove droplets from the caps by centrifuging the tubes briefly.

2. Pipette the required volumes of components into an appropriately sized clear
(non-colored) polypropylene tube:

Reaction component Volume per reaction
Master Mix 7.5 L
Primer Set 2.5puL

Note: Include volume for additional reactions to provide excess volume for the
loss that occurs during reagent transfers.
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Chapter 2 Perform PCR

Prepare the amplification kit reactions

10.

Vortex the reaction mixture for 3 seconds, then centrifuge briefly.

Dispense 10 uL of reaction mixture into each reaction well of a MicroAmp"™
Optical 96-Well Reaction Plate or each MicroAmp " tube.

Adjust the sample input amount and volume as needed:

Note: The optimum DNA input is 500 pg.

* If total sample input amount is >500 pg of DNA, dilute with low-TE buffer to
achieve a 500 pg input in a 15-pL volume.

¢ If total sample input volume is <15 uL, bring to volume with low-TE buffer
to achieve a 15-uL input volume.

Prepare samples as shown in the following table, then add them to the
appropriate well or tube (final reaction volume is 25 pL).

Sample Add
Negative control 15 pL of low-TE buffer
Test sample 15 pL of DNA
Positive control Combine, then add to the reaction well or tube:

e 5uL DNA Control 007 (0.1 ng/pL)
e 10 pL of low-TE buffer

0 Prepared in step 5.

Seal the MicroAmp " Optical 96-Well Reaction Plate with MicroAmp " Clear
Adhesive Film or MicroAmp" Optical Adhesive Film.

Vortex the plate or tubes at medium speed for 3 seconds.

Centrifuge the tubes or plate at 3,000 rpm for approximately 30 seconds in a
tabletop centrifuge (with plate holders, if using 96-well plates).

Amplify the samples.

IMPORTANT! See “Instruments and software compatibility” on page 15 for a list
of validated thermal cyclers.
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Perform PCR

Perform PCR

IMPORTANT! This kit is validated for use with the thermal cyclers listed in
“Instruments and software compatibility” on page 15.

1. Program the thermal cycling conditions.

IMPORTANT! If you are using the:

. ProFlex " PCR System, select 9700 Simulation Mode.
. GeneAmp'" PCR System 9700, select the Max ramping mode.

. Veriti" Thermal Cycler, set up the method using the Convert a Method tool
and select 9700 Max Mode.

Do not use 9600 emulation mode.

Initial Cycle (30 cycles) Final

incubation . Final hold
step Denature Anneal Extend extension
HOLD CYCLE HOLD HOLD
95°C, 96°C, 59°C, 65°C, 60°C, Aol

1 minute 5 seconds 21 seconds | 29 seconds 5 minutes

1 The infinity (eo) setting allows an unlimited hold time.

2. Load the plate into the thermal cycler, close the heated cover, then start the run.

IMPORTANT! If you are using a GeneAmp ' PCR System 9700 and adhesive clear
film instead of caps to seal the plate wells, place a MicroAmp " Optical Film
Compression Pad (Cat. No. 4312639) on top of the plate to prevent evaporation
during thermal cycling. The Veriti Thermal Cycler and the ProFlex ' PCR
System do not require a compression pad.

3. When the run is complete, store the amplified DNA.

Then place at...
2°C to 8°C
-25°C to -15°C

If you are storing the DNA...

<2 weeks

>2 weeks

IMPORTANT! Protect the amplified DNA from
light.

NGM Detect™ PCR Amplification Kit User Guide 21
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Chapter 2 Perform PCR

Direct amplification

Direct amplification

22

FTA" cards and non-chemically treated bloodstain cards are useful for the collection,
storage, and processing of biological samples. A small punch disc of the card
containing the sample can be placed directly into an amplification tube or 96-well
plate, washed, then amplified, without transferring the disc.

Our studies indicate that a 1.2-mm bloodstained disc contains approximately 5 ng—

20 ng of DNA. Because of the high quantity of DNA, a lower cycle number is required
to produce on-scale data. In our testing, an appropriate cycle number for this high
quantity DNA was 26 cycles. We recommend that each laboratory determine the
optimum cycle number which is based on internal validation studies.

Note: This kit is not fully validated for use with direct amplification. Perform your
own validation for this purpose or use the NGM SElect " Express kit for direct
amplification of database samples.

In the example that is shown in Figure 3, a 1.2-mm disc of a bloodstained FTA™ card
was purified using one wash with FTA™ Purification Reagent and one wash with 1X
low TE buffer, followed by a short drying step. The sample was then amplified
directly in the well of a standard 96-well amplification MicroAmp " plate for 26 cycles.

100 120 180 20 250 a0 a0 30
32000
21000
2000
2000
18000
12000,
a0
w0
i
o

Figure 3 Combined dyes electropherogram of a 1.2-mm FTA™ bloodstain disc amplified
for 26 cycles with the NGM Detect™ kit on an Applied Biosystems™ 3500xL Genetic Analyzer
(Y-axis scale 0 to 33,000 RFU).

[] Mark Sample for Deletion

420 a0
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Allelic ladder requirements for electrophoresis ........................... 23

Materials required for electrophoresis ..................... ... ... ... ... 24

Set up the 3500/3500xL instruments for electrophoresis (before first use

of the Kit) .. ... o 24
B Prepare samples for electrophoresis (3500 Series and 3130

Series INStruUmMents) . ... ..ottt e 27
B Set up the 3130/3130xI instruments for electrophoresis (before first use

of the Kit) .. ... 28
B Prepare samples for electrophoresis (3500 Series and 3130

Series INStruUmMEents) . ... ...ttt e 30

Allelic ladder requirements for electrophoresis

To accurately genotype samples, you must run an allelic ladder with the samples.

Number of One .
. s Number of samples per allelic
Instrument allelic ladders injection
ladder(s)
to run equals
3500 1 per 3 injections | 8 samples 23 samples + 1 allelic ladder
3500x/ 1 perinjection 24 samples 23 samples + 1 allelic ladder
3130 1 per 4 injections | 4 samples 15 samples + 1 allelic ladder
3130x/ 1 perinjection 16 samples 15 samples + 1 allelic ladder

IMPORTANT! Variation in laboratory temperature can cause changes in fragment
migration speed and sizing variation between runs. Follow the guidelines in the
preceding table, which should account for normal variation in run speed. Perform
internal validation studies to verify the required allelic ladder injection frequency, to
ensure accurate genotyping of all samples in your laboratory environment.

It is critical to genotype using an allelic ladder run under the same conditions as the
samples. Size values obtained for the same sample can differ between instrument
platforms, because of different polymer matrices and electrophoretic conditions.
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| Materials required for electrophoresis

Materials required for electrophoresis

Appendix B, “Materials required but not supplied” lists the required materials that
are not supplied with this kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not
in use.

Set up the 3500/3500xL instruments for electrophoresis (before first
use of the kit)

Electrophoresis
software setup

The following table lists the data collection software and the run modules that you
can use to analyze PCR products that are generated by this kit. For details on the
procedures, see the documents that are listed in “Documentation and support” on
page 136.

Note: We conducted validation studies for the kit using the 3130xI, 3500, or 3500xL
configurations.

Genetic Operating | Data Collection Additional Instrument protocols, run modules, and
Analyzer System Software software conditions
3500 Windows" 3500 Data HID Updater 3500 | Set up the following conditions:
3500xL Vista Collection DCv2 e Run module: HID36_POP4 [HID36_POP4xL for
Software v1 (Cat. No. 4480670) 3500xL)
o Injection conditions!"): 1.2 kV/11 sec (20 sec
for 3500xL)
¢ Run conditions: 13 kV/1500 sec (13 kV/1500
sec for 3500xL)
e Dye Set J6-T
3500 Windows" 7 3500 Data HID Updater 3500 |Same as 3500 Data Collection Software v1 listed
3500xL Collection DCv2 above
Software v2 (Cat. No. 4480670)
3500 Windows" 7 3500 Data None Same as 3500 Data Collection Software v1 listed
Collection above
3500xL Software v3

[0 Qur studies indicate that the injection conditions that are documented generate profiles from 0.5 ng of input DNA with heterozygous peak height
averages between 4,000~ 10,000 RFU (3500 or 3500xL} with no instances of allelic dropout and minimal occurrence of off-scale allele peaks.
However, individual CE instrument signal intensities can vary, therefore changes to injection parameters may need to be explored and validated
to deliver the best results on your specific system. Large deviations from the recommended injection parameters could affect the performance
of the size standard and/or allelic ladder, therefore validation is recommended.

24
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Set up the 3500/3500xL instruments for electrophoresis (before first use of the kit]
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Create a 3500 QC The NGM Detect " kit has been validated with data that was analyzed using the Local
protocol Southern method (60460 base pairs).

1. In the Library tab, open the QC Protocol window.

2. Create a new QC protocol :

a. Name the new QC protocol according to your laboratory naming
convention.

b. Set the following parameters:

Parameter Setting
Size Standard GS600_LIZ_(60-460)
Size Range Partial
Sizing Start Size 60 bp
Sizing Stop Size 460 bp
Size Calling Method Local Southern Method
After checking the "Use Baselining” 33
box: Baseline Window Pts.
Peak Window Size "

NGM Detect™ PCR Amplification Kit User Guide 25
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Perform spectral
calibration

26

c. Click Save.

_® Edit QC Protocol [ % |

Setup a QC Protocol Egi

* Protocol MName:

Description:

Size Standard: l (G5600_LIZ_(60-460) -

Sizecaller: SizeCallervil0 -

Analysis Settings | (508 Settings|

Analysis Range: Sizing Range: Size Calling Method: |Local Southern -

Analysis Start Point: | 0 Sizing Start Size: 60
Analysis Stop Peint: | 1000000 Sizing Stop Size: 460
Blue Green Yellow Red Furple Orange

Peak Amplitude Threshold

Common Settings

Use Smoothing | [Light =

Use Baselining (Baseline Window (Pts)) 33

Minimum Peak Half Width 2

Peak Window Size 11

Polynemial Degree 3

Slope Threshold Peak Start 0.0

Slope Threshold Peak End 00

Close Save

3. Add the QC protocol to the HID assay.
Perform a spectral calibration using the DS-37 Matrix Standard Kit (Dye set J6-T, 6-
dye) (J6-T Dye Set) (Cat. No. A31234).

Note: Since J6-T is a new dye set, create a new dye set in the Data Collection Software
before running a spectral calibration. For instructions on creating a new dye set, see
the "Create a New Dye Set" section of the 3500/3500xL Genetic Analyzer with 3500 Series
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Prepare samples for electrophoresis (3500 Series and 3130 Series instruments/

P

Data Collection Software v2 User Guide (Cat. No. 4476988). Use the J6 template to set up
the J6-T dye set.

The following figure is an example of a passing 6-dye spectral calibration.

HEDEERED

Prepare samples for electrophoresis (3500 Series and 3130 Series
instruments)

This procedure applies to the 3500 Series and 3130 Series instruments.

Prepare the samples for electrophoresis immediately before loading.

1. Pipet the required volumes of components into an appropriately sized

polypropylene tube:
Reagent Volume per reaction
GeneScan"-600 LIZ"™ Size Standard v2.0 0.4 pL
Hi-Di" Formamide 9.6 L

Note: Include volume for additional samples to provide excess volume for the
loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.

2. Vortex the tube, then briefly centrifuge.

3. Into each well of a MicroAmp'" Optical 96-Well Reaction Plate, add:

* 10 pL of the formamide/size standard mixture
¢ 1 uL of PCR product or Allelic Ladder

Note: For blank wells, add 10 pL of Hi-Di" Formamide.
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4. Seal the reaction plate with appropriate septa, then briefly vortex and centrifuge
the plate to ensure that the contents of each well are mixed and collected at the
bottom.

5. Heat the reaction plate in a thermal cycler at 95°C for 3 minutes.

6. Immediately place the plate on ice for 3 minutes.

7. Place the sample tray on the autosampler, then start the electrophoresis run.

Set up the 3130/3130x/ instruments for electrophoresis (before first
use of the kit)

Electrophoresis The following table lists the data collection software and the run modules that you
software setup can use to analyze PCR products generated by this kit. For details on the procedures,
see the documents listed in “Documentation and support” on page 136.
. . Data
Genetic Operating Collection Additional software Run modules and conditions
Analyzer System
Software
31301 Windows 7 | Data Collection | 3130/3730 DC v4 6- | Set up the following conditions:
Software v4 | Dye Module v + HIDFragmentAnalysis36_POP4_1
* Injection conditions!?: 3 kV/4 sec
e Run conditions: 14 kV/1600 sec
e Dye Set J6-T
3130x!( Set up the following conditions:
e HIDFragmentAnalysis36_POP4_1
* Injection conditions!?: 3 kV/5 sec
* Run conditions: 14 kV/1600 sec
e Dye Set J6-T

[l We conducted validation studies using the 3130x 3500, and 3500xL configurations.

(2 Qur studies indicate that the injection conditions that are documented generate profiles from 0.5 ng of input DNA with heterozygous peak height
averages between 2,000~ 4,000 RFU (3130 or 3130x4 with no instances of allelic dropout and minimal occurrence of off-scale allele peaks.
However, individual CE instrument signal intensities can vary, therefore changes to injection parameters may need to be explored and validated
to deliver the best results on your specific system. Large deviations from the recommended injection parameters could affect the performance
of the size standard and/or allelic ladder, therefore validation is recommended.

Obtain and 1. Confirm that you are running Data Collection Software v4 (Help » About).
activate 6-dye
license 2. Obtain a 3130 DC v4 6-Dye Module v1 License key. Contact your local Human

Identification representative for information.
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3. Ensure that all network cards in the computer are enabled.

IMPORTANT! You can run the 3130 Series Data Collection Software v4 using
only the network cards that are enabled when you activate the software license.
For example, if you activate the software when your wireless network card is
disabled, you will not be able to run the software when the wireless network card
is enabled.

4. Select Tools » License Manager to display the Software Activation dialog box.

3xnx Series Data Collection Software 4 Software Activation 8

1.  Requestlicense file for Computer ID:
d4bed9a7d416 ddbed9a7d417

This ID is unigue fo s computer and cannot be used fo obtain 3 ficense fe for another computer,

a. Enter the license key (from CD ar email):

b. Enter your email address:

john.doe@thermofisher. com

c. Is this computer currently connected to the internet?

‘Yes., Connected. ] [ Mo. Mot Connected.

2. Refrieve the license file from email, then save it to the desktop of this computer.

3. Find the license file:

Browse...

4, Click Install and Validate License l

Close

5. Request the software license file by performing steps 1a, 1b, and 1c as listed on
the activation screen. The license file will be emailed to you.

6. Obtain the software license file from your email.
7. Make a copy of the software license file and keep it in a safe location.

8. Copy the software license file to the desktop of the Data Collection Software v4
computer.

9. If the Software Activation dialog box has closed, select Tools » License Manager.
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10. Click Browse, then navigate to the software license file saved on your computer.

11. Click Install and Validate License.
A message is displayed when the license is installed and validated.

12. Click Close.

Pe'jforn? spectral Perform a spectral calibration using the DS-37 Matrix Standard Kit (Dye set J6-T, 6-
calibration dye) (J6-T Dye Set) (Cat. No. A31234).

The following figure is an example of a passing 6-dye spectral calibration.

50 100 150 200 250
Intensity vs Pixel Number

1700 1900 2100 2300 2500 2700 2900 3100 3300 3500 3700

Intensity vs Scan Number

Prepare samples for electrophoresis (3500 Series and 3130 Series
instruments)

This procedure applies to the 3500 Series and 3130 Series instruments.

Prepare the samples for electrophoresis immediately before loading.

1. Pipet the required volumes of components into an appropriately sized

polypropylene tube:
Reagent Volume per reaction
GeneScan -600 LIZ"™ Size Standard v2.0 0.4yl
Hi-Di" Formamide 9.6 uL

Note: Include volume for additional samples to provide excess volume for the
loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.

2. Vortex the tube, then briefly centrifuge.
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3. Into each well of a MicroAmp"" Optical 96-Well Reaction Plate, add:
* 10 pL of the formamide/size standard mixture
* 1 uL of PCR product or Allelic Ladder

Note: For blank wells, add 10 pL of Hi-Di" Formamide.

4. Seal the reaction plate with appropriate septa, then briefly vortex and centrifuge
the plate to ensure that the contents of each well are mixed and collected at the
bottom.

5. Heat the reaction plate in a thermal cycler at 95°C for 3 minutes.

6. Immediately place the plate on ice for 3 minutes.

7. Place the sample tray on the autosampler, then start the electrophoresis run.
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Analyze data with GeneMapper
/D-X Software

B Overview of GeneMapper ID-X Software ........................ oL, 32
B  GeneMapper' ID-X Software analysis of the NGM Detect ™ kit ............ 33
B Allelic ladder requirements for data analysis ............................. 34
B File names and versions used in this section .......................... ... 34
B Set up the GeneMapper " ID-X Software for analysis (before first use of

thekit) .. ... o 35
B Createananalysismethod ........ ... ... ... . . 40
B Create a size standard definition fileif needed ........................... 48
B Analyze and edit sample files with GeneMapper ID-X Software ............ 50
B Examine oredita project ..............iiii 51
B For more information on using the GeneMapper™ ID-X Software .......... 51

Overview of GeneMapper ID-X Software

32

GeneMapper' " ID-X Software is an automated genotyping software application for
forensic casework, databasing, and paternity data analysis.

GeneMapper' " ID-X Software v1.5.2 or later analyzes 4-dye, 5-dye, and 6-dye data and
is required to correctly analyze data that is generated using the NGM Detect " kit.
After electrophoresis, the data collection software stores information for each sample
in a .fsa or .hid file. The GeneMapper ' ID-X Software v1.5.2 or later allows you to
analyze and interpret the data from the .fsa or .hid files.

™

Prior versions of GeneMapper ~ ID-X Software (v1.2 and above) are capable of
analyzing data that is generated using the NGM Detect " kit. However, some data
quality assessment tools are not fully functional on versions prior to v1.5.2. Details on
the data assessment functionality added to specific versions of GeneMapper " ID-X
Software are found in the release notes for each version. To summarize:

* In versions prior to v1.4, samples show a red flag for the CGQ if the Y-indel peak
is missing, for example, with a female DNA sample. This occurs because the
absence of the Y-indel peak triggers the Allele Number Rule.

* In versions prior to v1.5.2, when the sample type is set as "Negative Control" the
software will assign red CGQ flags. This occurs even if the negative control
sample is valid, that is, it contains no peaks above the PAT in the STR, AMEL, and
Y-indel marker ranges. The red flags appear because the presence of the IQC
peaks triggers the Allele Number Rule for this sample type (no peaks are
expected in a valid negative control sample).
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GeneMapper  /D-XSoftware analysis of the NGM Detect " kit

GeneMapper ' ID-X Software allows you to designate four sample types:
* Sample
* Positive Control
* Allelic Ladder

* Negative Control

GeneMapper ' ID-X Software has logic for Negative Control sample type
assignments, whereby the software generates red flags on the Genotype Quality (GQ)
indicators when peaks are present above the Peak Amplitude Threshold (PAT)
designated in the analysis method.

™

The NGM Detect  PCR Amplification Kit includes the internal quality control (IQC)
system for PCR. In this system, two synthetic targets in the primer mix are amplified
with the sample under test. The IQC system allows you to determine whether PCR
has been successful in the absence of peaks from the sample.

In versions prior to v1.5.2, when the sample type is set as "Negative Control" the
software will assign red CGQ flags. This occurs even if the negative control sample is
valid, that is, it contains no peaks above the PAT in the STR, AMEL, and Y-indel
marker ranges. The red flags appear because the presence of the IQC peaks triggers
the Allele Number Rule for this sample type (no peaks are expected in a valid
negative control sample).

Thermo Fisher Scientific has developed the NGM Detect " kit using version 1.5.2 of the
GeneMapper ' ID-X Software. This version includes updated logic for the Negative
Control sample type. It allows the IQC marker GQ to flag green in the presence of the
IQC peaks.

A software patch that updates GeneMapper  ID-X Software v1.5 to v1.5.2 is available
at thermofisher.com/us/en/home/technical-resources/software-downloads/
genemapper-id-x-software.html.
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Allelic ladder requirements for data analysis

Allelic ladder requirements for data analysis

HID analysis requires at least one allelic ladder sample per run folder. Perform
the appropriate internal validation studies before you use multiple allelic ladder
samples in an analysis.

For multiple allelic ladder samples, the GeneMapper " ID-X Software calculates
allelic bin offsets by using an average of all allelic ladders that use the same panel
in a run folder.

Allelic ladder samples in an individual run folder are considered to be from a
single run. When the software imports multiple run folders into a project, only
the ladders in their respective run folders are used for calculating allelic bin
offsets and subsequent genotyping.

Allelic ladder samples must be labeled as "Allelic Ladder" in the Sample Type
column in a project. Analysis will fail if the Allelic Ladder Sample Type is not
specified.

Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples, to ensure proper allele
calling.

Alleles that are not in the allelic ladders do exist. Off-ladder (OL) alleles can
contain full and/or partial repeat units. An off-ladder allele is an allele that occurs
outside the bin window of any known allelic ladder allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory protocol.

File names and versions used in this section

34

The file names and version numbers of panel, bin, and stutter files that are shown in
this section may differ from the file names that you see when you download or import

files.

If you need help to determine the correct files to use, contact your local Human
Identification representative, or go to thermofisher.com/support.
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%

Set up the GeneMapper  /D-XSoftware for analysis (before first use

of the kit)

Workflow: Set up
GeneMapper™
ID-X Software

Check panel, bin,
and stutter file
versions on your
computer

(If needed]
Download newer
versions of panel,
bin, and stutter
files

Before you use GeneMapper ' ID-X Software to analyze data for the first time, you
must do the following;:

“Check panel, bin, and stutter file versions on your computer” on page 35
v
“(If needed) Download newer versions of panel, bin, and stutter files” on page 35
v
“Import panels, bins, and marker stutter” on page 36
v

“(Optional] Define custom table or plot settings” on page 39

. Start the GeneMapper ' ID-X Software , then log in with the appropriate user

name and password.

. Select Tools » Panel Manager.

. Check the version of files that are currently available in the Panel Manager:

a. Select Panel Manager in the navigation pane.

b. Expand the Panel Manager folder and any subfolders to identify the
analysis file version that is already installed for your kit choice.

. Check the version of files available for import into the Panel Manager:

a. Select Panel Manager, then select File » Import Panels to open the Import
Panels dialog box.

b. Navigate to, then open the Panels folder, then check the version of panel,
bin, and stutter files installed.

. Check for newer versions of the files as described in the next procedure.

. Go to thermofisher.com/us/en/home/technical-resources/software-downloads/

genemapper-id-x-software.html.

2. If the file versions listed are newer than the versions on your computer,

download the file NGM Detect Analysis Files.

Note: When downloading new versions of analysis files, see the associated Read
Me file for details of changes between software file versions. Perform the
appropriate internal validation studies before using new file versions for
analysis.

. Unzip the file.
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Import panels,
bins, and marker
stutter

36

To import the latest panel, bin set, and marker stutter from the website into the
GeneMapper [D-X Software database:

1.

Start the GeneMapper ' ID-X Software, then log in with the appropriate user
name and password.

Select Tools » Panel Manager. B9 Panel Manages I

File Edt Bins View Help
F N 8 N

o, PANEl Manager

Find, then open the folder containing the panels,
bins, and marker stutter:

a. Select Panel Manager, then select File » Import Panels to open the Import
Panels dialog box.

b. Navigate to, then open the NGM Detect Analysis Files folder that you
unzipped in the previous procedure.

Select NGM_Detect_Panels.txt, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager, NGM_Detect_Panel. This folder contains the panel and associated
markers.

4? Import Panels %
Lookin: | }) NGM Detect Analysis Files v3 ~| & *—-E|
D= _ NGM_Detect Bins_v3.tt
ol || NGM_Detect_Panel_v3.bt

Recent Items | NGM_Detect_stutter_ v3.bet

Desktop

E
My Documents

File name: NGM_Detect Panel 3. it
. . - -
A esoftper [airies -
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5. Import the bins file:
a. Select the NGM_Detect_Panel folder in the navigation pane.

-
¥ Panel Manager . s u

-

Eile Edit Bins Yiew Help

|
@ X | B M B enset [noupecsns. - /| i % B B H  BEEN
-~ Copriprerd

-[CINGM_Detect_v2.1 Dare] Harmie
[E28 i MGM_Detect_v3

=||1 NGM_Detect_Panel_v3  Jnul

o [ concl ][ sooly || beb |

— ——

—

b. Select File » Import Bin Set to open the Import Bin Set dialog box.
c. Navigate to, then open the NGM Detect Analysis Files folder.

d. Select NGM_Detect_Bins.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
NGM_Detect_Panel folder.

Lookin: | |. NGM Detect Analysis Files v3

B NGM_Detect Bins_v3.t¢
. NGM_Detect_Panel_v3.bct
__ NGM_Detect_stutter_v3.txt

NGM_Detect_Bins_v3.txt

Files of type: | Al Files
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6. (Optional) View the imported panels and bins in the navigation pane: Double-
click the NGM_Detect_Panel folder.

The panel information is displayed in the right pane and the markers are
displayed below it.

-
2 Panel Manager ~ . — e Zo]
File Edit Bins View Help
" = + NGM_Detect_Bins N 2

X | BF M M | W ™ | 8nSet: NGM Detect Bins_v3 |G E>E BEEEEEN| o
G v3 A Muker Name | Dye Color |Min Size |Max Size | Cantrol Allekes Miker | Commments ¥ Maker | Ladder Alleles
- 1QCS 1 o Joue [e40 [0 |2 4 none @] 1,2
[#-D251338 2 |D251338 ’Eue 80,0 1700 ['20,23" 4 none B 11,12,13,14,15,16,17,18,1
G SE33 0 g <
B.100 3 [sE33 |Bue [180.0 [3510  [17,25.2 4 none [ [42638911,12,13,14,1¢
5 D165539 4 1oct Blue  [445.0 |453.0 |2 4 none @] 1,2
- D18S51 5 |p16ss3s Green |65.0  |119.0 |'9,107 4 none [ [58910,11,12,13,14,15
- THO1 & |D18551 Green |121.0 |215.0 |"12,15" 4 none @] 7,9,10,10.2,11,12,13,13.2,
- D125391 W "
. D3SL3B 7 |THo1 Green |218.0 |268.0 |'7,9.3 4 none 0 4567,89,93,10,11,12,1
& FGA 3 [D125391 Green |273.0 |342.0 |'18,19" 4 none @] 14,15,16,17,18,19,19.3,20
- Yindel =l[s 1 elow 1050 162 1 4 none ,10,11,12,13,14,15, 16,
del 3 D351358 Vell 05.0 (1620 |'15,16" 9,10,11,12,13,14,15,16,17
[ AMEL 10 |FGA Yelow |163.0 |330.0 |"24,26" 4 none @] 13,14,15,16,17,18,19,20,2
B VWA -
. p21511 11 |Yindel Red  [87.0 1000 |2 B none 1,2
5 DIS1656 12 [AMEL Red  [105.0 |117.0 |"%Y" 9 none 0 %Y
[ D25441 13 VWA Red  [119.0 1860 |'14,16" 4 none @] 11,12,13,14,15,16,17,18,1
[#-D8S1179 14 D21511 Red 1910 [260.0 |"28,31" 4 none @] 24,24.2,25,26,27,28,28.2,:
[ D195433 e ;
. 02251045 15 DI51656 Red  |262.0 |323.0 |'13,16 4 none 1 [910,11,12,15,14,14.3,15,
& D1051248 ~| |16 25441 Red  [328.0 |380.0 |'14,15" 4 none [ [89,10,11,113,12,13,14,1¢
« D ’ 17 0851179 Puple [85.0  |160.0 |"12,13" 4 none [ [567,8510,11,12,13,14,1
. Reference Samples 18 |D195433 Puple |166.0 2350 |"14,15" 4 none 0 [67.8910,11,12,12.2,13,1
19 D2251045  |Purple [239.0 (2910 |'11,16" 3 none 01 |7,89,10,11,12,13,14,15,1¢
20 DI0S1248  |Purple  |296.0 |355.0 |"12,15" 4 none [ [89,10,11,12,13,14,15,16,
(o] [ ]

7. Import the stutter file:
a. Select the NGM_Detect_Panel folder in the navigation panel.

b. Select File » Import Marker Stutter to open the Import Marker Stutter
dialog box.

c. Navigate to, then open the NGM Detect Analysis Files folder.
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d. Select NGM_Detect_Stutter.txt, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin set
in the NGM_Detect_Panel folder and overwrites any existing stutter ratios
associated with the panels and bins in that folder.

? Import Marker Stutter

I
o b

Recent Items

Desktop

T
&
My Documents

Ay
| =

Computer

Look in: [

- M
- NGM Detect Analysis Files v3 > 2B
|| NGM_Detect_Bins_v3.txt
| | NGM_Detect_Panel_v3.txt
B NGM _Detect_stutter v3.0d
File name: NGM_Detect_stutter_v3.txt Import

\

8. View the imported marker stutters in the navigation pane:
a. Double-click the NGM_Detect_Panel folder to display the folder.

b. Double-click the folder to display its list of markers below it.

c. Double-click a marker to display the Stutter Ratio & Distance view for the
marker in the right pane.

p
4® Panel Manager

i |

File Edit Bins View Help

g d ‘ FrEN ‘ W |Em5et: INGM_Detact_Bins_v3

JMLESE BEEEEEENE| e

=1+ NGM_Detect_Panel_v3
1005

Please enter the stutter filter(s) for D231338 marker here.ff left blank, the global stutter filter will be applied

=t D251338
[Stuier Rato & Distance Minus Stutter Plus Stutter
[+~ SE33 |
IQCL L Ratio From Distance To Distance Ratio From Distance To Distance
[+~ D165539 i 1 L1761 3.25 4.75 1 L1155 3.25 4.75
D18S51 ) 2 2
THOL
D125391 3 3
D351358 4 4
- FGA
< ,
- g Reference Samples

9. Click Apply, then click OK to add the panel, bin set, and marker stutter to the
GeneMapper " ID-X Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the
panels, bin sets, and marker stutter are not imported into the GeneMapper " ID-X

Software database.

Default views for table and plot settings are provided with the software. For

™

information on defining custom views, see GeneMapper ~ I1D-X Software Getting Started

Guide— Basic Features.
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Create an analysis method

Create an analysis method

Create an analysis
method

40

IMPORTANT! Analysis methods are version-specific, so you must create an analysis
method for each version of the software. For example, an analysis method that is
created in GeneMapper  ID-X Software version 1.2 is not compatible with analysis
methods that are created in earlier versions of software, or with GeneMapper
Software v3.2.1.

1.

Select Tools » GeneMapper® ID-X Manager to open the GeneMapper ID-X
Manager.

-

¥ GeneMapper® ID-X Manager

Find Name Containing:

Projects | Analysis Methods | Table Settings | Piot Settings | Matrices | Size Standards | Report Settings|
[ Mew.. || open.. || savess.. |[ Import.. |[ Export.. |

it (s

2. Click the Analysis Methods tab, then click New to open the Analysis Method

Editor with the General tab selected.

Enter the settings shown in the figures on the following pages.

Note: The Analysis Method Editor closes when you save your settings. To
complete this step quickly, do not save the analysis method until you finish
entering settings in all of the tabs.

4. After you enter the settings on all tabs, click Save.
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Enter Analysis Enter General tab settings

Method settings 1. Enter a Name and select the Security Group appropriate for your software

configuration.

'l ™
Analysis Method Editor [
 General:| Allele | Peak Detector | Peak Quality | SQ & GQ Settings|
—Analysis Method Description
Mame: MGM Detect w3
Security Group: .GeneMapper ID-X Security Group - .
Description: -
=
Instrument:
I Analysis Type: HID I
Save As ] [ Save ] [ Cancel ] [ Help ]
L o

2. (Optional) Enter a Description and Instrument.
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Enter Allele tab settings

IMPORTANT! Perform appropriate internal validation studies to determine the
appropriate settings to use.

1. Select the NGM_Detect_Bins_v3 bin set.

r 4
Analysis Method Editor ® |
| General | Allele | peak Detector | Peak Quality | SQ & GQ Settings |
Bin Set:  NGM_Detect Bins_v3 -
IUse marker-specific stutter ratio and distance if available
Marker Repeat Type: Tri Tetra Penta Hexa
Global Cut-off Value 0.0 0.0 0.0 0.0
MinusA Ratio 0.0 0.0 0.0 0.0
MinusA Distance From (0.0 0.0 0.0 0.0
To 0.0 0.0 0.0 0.0
Global Minus Stutter Ratio 0.0 0.0 0.0 0.0
Global Minus Stutter Distance  From  |2.25 3,25 0.0 0.0
Toe |3.75 4,75 0.0 0.0
Global Plus Stutter Ratio 0.0 0.0 0.0 0.0
Global Plus Stutter Distance From 0.0 0.0 0.0 0.0
To 0.0 0.0 0.0 0.0
Amelogenin Cutoff 0.0
I ’ Range Filter. .. Factory Defaults ] l
Save As ] [ Save ] [ Cancel ] [ Help ]
L A

Figure 4 Settings used in developmental validation of the kit

2. (Optional) To apply the stutter ratios contained in the NGM_Detect_Stutter.txt,
select the Use marker-specific stutter ratio and distance if available checkbox
(selected by default).
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Create an analysis method

3. If using GeneMapper  ID-X Software v1.0.1 or later, enter values for the 4

Marker Repeat Types.

4. Enter the appropriate filter settings.

Enter Peak Detector tab settings

Enter the appropriate values:

Field

Values to enter or select

Additional information

Ranges

Enter the values shown in Figure 5.

Note: The read region for the NGM Detect™
kit is 64 to 458 bp.

Peak Detection

Enter the appropriate settings.

IMPORTANT! Perform appropriate internal
validation studies to determine the
appropriate peak amplitude thresholds for
interpretation of data.

The software uses these parameters to
specify the minimum peak height, in order to
limit the number of detected peaks.
Although GeneMapper ™ /D-XSoftware
displays peaks that fall below the specified
amplitude in electropherograms, the
software does not label or determine the
genotype of these peaks.

NGM Detect™ PCR Amplification Kit User Guide
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Create an analysis method

Field

Values to enter or select

Additional information

Smoothing and
Baseline

Enter the values shown in Figure 5, or adjust
as needed dependent on the polymer you are
using.

Size Calling Method

Select Local Southern Method, or another
method if validated by your internal
validation.

Normalization

(Optional)Select the Normalization
checkbox.

A Normalization checkbox is available on
this tab in GeneMapper™ /D-X Software for
use in conjunction with data run on the 3500
Series Genetic Analyzers.

44
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3

Note: The read region for the NGM Detect " kit is 64 to 458 bp.

Analysis Method Editor & |

General | Allele | Peak Detector | Peak Quality | SQ & GQ Settings | i

Peak Detection Algorithm: Advanced

Ranges Peak Detection L
Il | Analysis . Sizing _ Peak Amplitude Thresholds: i
Full Range ~  Partial Sizes - | B: R 1
Start Pt:|0 Start Size: 60 ' '
I Stop Pt: [ 10000 Stop Size: | 460 G P:
¥: O
—Smoothing and Baselining
Min. Peak Half width: |2 pts
Smoothing (71 Mone
_ i : 3
@ Light Polynomial Degree
(7 Heavy Peak Window Size: 11 pts
Baseline Window: |33 pts Slope Thresheld
Peak Start: 0.0
—Size Calling Method Peak End: 0.0
(71 2nd Order Least Squares
(7 3rd Order Least Squares Mormalization
(;j Cubic Spline Interpolation [ Use Mormalization, if applicable
(@ Local Southern Method
(7 Global Southern Method

’ Factory Defaults

Save As ” Save H Cancel ” Help ]

LS y

Figure 5 Settings used in developmental validation of the kit
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Create an analysis method

Enter Peak Quality tab settings

IMPORTANT! Perform the appropriate internal validation studies to determine the
heterozygous and homozygous minimum peak height thresholds, maximum peak
height threshold, and the minimum peak height ratio threshold for interpretation of
data.

Enter the following values:

Analysis Method Editor = |

| General | Allele | Peak Detector | Peak Quality | 50 &GQ Setﬁngs|
Min/Max Peak Height (LPHMPH)

Homozygous min peak height
Heterozygous min peak height
Max Peak Height (MPH)

II Peak Height Ratio (PHR)
Min peak height ratio

Broad Peak (BD)
Max peak width (basepairs) 1.5
Allele Mumber (AM)
Max expected alleles:
For autosomal markers & AMEL 2
For ¥ markers 1
Allelic Ladder Spike
Spike Detection Enable .
Cut-off Value 0.2

Sample Spike Detection
Spike Detection Enable

’ Factory Defaults

Save As ” Save H Cancel ” Help ]
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Create an analysis method

Enter SQ and GQ tab settings

IMPORTANT! The values that are shown are the software defaults and are the values
we used during developmental validation. Perform appropriate internal validation
studies to determine the appropriate values to use.

Enter the following values:

= =
Analysis Method Editor
General | Allele | Peak Detector | Peak Quality | 5Q & GQ Settings |
Quality weights are between 0 and 1.
~Sample and Control GQ Weighting
Broad Peak (BD) 0.8 | Allele Number (AN) 1.0
Out of Bin Allele (BIN) 0.8 Low Peak Height (LPH) 0.3
Overlap (OVL) 08 | Maxx Peak Height (MPH) 0.3
|| Marker Spike (sPK) 0.3 Off-scale (05) 0.8
AMEL Cross Check (ACC) (0.0 | Peak Height Ratio (PHR) 0.3
Control Concordance (CC) Weight = 1.0 (Only applicable to controls)
~50) Weighting
Broad Peak (BD) 0.5
~Alelc Ladder GO Weighting
Spice (SSPK/SPK) s Off-scale (05) 1 -
5Q & GQ Ranges
 PassRange:  [lowQualityRange:
SangQuaity:  From 075 | 910 Fom0.0to 0.25 |
Genotype Quality: From 0.75 | to10 From0.0to |0.25
l Reset Defaults

[ Sevess |[ save || Concd |[ Heb |

Note: Set the ACC GQ Weighting according to the values you determine during
internal validation studies of the ACC PQV. For example, set the ACC GQ Weighting
to 0.3 or higher to flag samples in which the Amelogenin result is anything other than
X, X or X, Y, or does not agree with the results for the Y indel marker.
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Create a size standard definition file if needed

About the
GS600_LIZ_ (60-
460) size standard
definition file

Create a size
standard
definition file

48

If you cannot use the default settings that are provided, create a new size standard
definition file.

The GS600_LIZ_(60-460) size standard definition that is provided with GeneMapper -
ID-X Software and used with the Local Southern size calling method contains the
following peaks: 60, 80, 100, 114, 120, 140, 160, 180, 200, 214, 220, 240, 250, 260, 280,

300, 314, 320, 340, 360, 380, 400, 414, 420, 440, and 460.

This size standard definition has been validated for use with this kit on the genetic
analyzers listed in “Instruments and software compatibility” on page 15. If you need
to create your own size standard definition, see “Create a size standard definition
file” on page 48.

1. Select Tools » GeneMapper ID-X Manager to open the GeneMapper ID-X
Manager.

2. Click the Size Standards tab, then click New.

-
¥ GeneMapper® ID-X Manager

Fird M C o Eairing:

Projects | Analysis Methods | Tabie Settings | Plot Settings | Matrices | Size Standards | Report Settings|

Mame Last Saved [Covinen Type Description
|CE_F_HID_GS500 {75-400) m:n-u:a-u-;lazzs;s[q-ﬁdx |Advanced

CE_F_HID_GS500 (75-4500 |zuu?-m3-uq I3:24:[||;mdx Advanced |
E_G5_HID_5500 2006-10-11 I3r|2::||;|nidx Advanced

|G5600_LIZ 2007-06-26 10:43; I[nl'fidx |Advanced
GSE00_LIZ+Mormalization_{ |2mz-m-ne |2:3?::||;mdx Advanced |
G5600_LIZ+Normalization _{ | 2007-06-27 01:43; I||;|nidx Advanced

| GSE00_LIZ_(E0-+60) 2012-08-06 |2:21::[nmidx |Advanced

G5600_LIZ_(50-400) Advanced

|znm-ne-2:r 0043 I||;rridx

[«

L1

3. Specify settings in the Size Standard Editor:

a.

b.

software configuration.

In the Size Standard Dye field, select Orange.

Enter a name as shown in the following figure or enter a new name.

In the Security Group field, select the Security Group appropriate for your
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Create a size standard definition file if needed

d. In the Size Standard Table, enter the peak sizes that correspond to your size

standard.

| 4® Size Standard Editor S

Edit

Mame:

Description:

—Size Standard Description

Security Group:

Size Standard Dye:

GS600_LIZ_{50-450)

:GeneMapper ID-X Security Group

'Dfange - '

FEe——
Ll

—Size Standard Table

Size in Basepairs

0.0

[ Insert H Delete

I.p

g0.0

100.0

$al | M2

114.0

120.0

140.0

m

1a0.0

150.0

£00.0

Z£14.0

220.0

240.0

250.0

14

2a0.0

15

£80.0

300.0

17

314.0

[ oK H Cancel ][ Help ]
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Analyze and edit sample files with GeneMapper /D-XSoftware

1. In the Project window, select Edit » Add Samples to Project, then navigate to the
disk or directory that contains the sample files.

2. Apply analysis settings to the samples in the project.

Parameter Settings

Sample Type Select the sample type.

Analysis Method Select NGM Detect Analysis Method (or the name of the
analysis method you created).

Panel Select NGM_Detect_Panel.
Size Standard Use a size range of 60-460 bp for Local Southern size calling
method [

[ The NGM Detect™ kit was originally validated with the GeneScan™-600 LIZ™ Size Standard v2.0. If you
use a different size standard, perform the appropriate internal validation studies to support the use of
this size standard with the NGM Detect™ kit.

3. Click Analyze, enter a name for the project (in the Save Project dialog box), then
click OK to start analysis.

* The status bar displays the progress of analysis as a completion bar.

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

¢ The Analysis Summary tab is displayed, and the Genotypes tab is available
when the analysis is complete.

elp

sis View To min
COH|%F DEEWU|@EGE| > @ | resto | [3000amanass B L,aR|De
- gdyProject samples | Analysis Summary | Genotypes
Bt 20
Analysis Summary Summary Generation Date: Dec
Select run folder to display: |Inj12018-08-14-14-57-25-847
Sample Status Total # of Samples |
Unanalyzed 0 |
Analyzed 24 |
U Analysis Setting Changed 0 |
Click a link below to display  filtered Samples Table containing only the samples selected
Alielic Ladder Quality per run folder (based on $Q and CGQ only)
Run Folder J__Total # of Analyzed Ladders I Il L& ]
/1 2018-08-14-14-57-26-847 | L [ N
Control Quality per project (based on sample PQVs: SOS, SSPK, MIX, OMR, SQ, CGQ)
Control Type Total # of Samples All thresholds met. @ oneor more.
Positive Control 0 0 0
[Custom Control [] [] 0
Negative Control 0 0 0
[Total 0 0 0

Sample Quality per project (based on sample PQVs: SOS, SSPK, MIX, OMR, $Q, CGQ)

I | Total # of samples |8 Alltreshoidsmet [ @) oneor more ]
samples | = | o |

\Analysis Completed.
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Examine or edit a project

Examine or edit a project

Display electropherogram plots from the Samples and Genotypes tabs of the Project
window to examine the data.

For more information on using the GeneMapperTM ID-X Software

See “Related documentation” on page 136 for a list of available documents.
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B Overview of the Internal Quality Control System ......................... 52
B Evaluatethe PCRreaction ........... ... . . il 52

Overview of the Internal Quality Control System

The Internal Quality Control System (IQC) is a tool that helps you to assess the PCR
reaction and, in conjunction with the STR marker data properties, infer whether a
sample is showing signs of degradation or inhibition. The primers for the two IQC
markers, IQCS and IQCL, amplify synthetic DNA targets included in the primer mix.
IQCS is a low molecular weight amplicon, 70 nt in length. Whereas, IQCL is a high
molecular weight amplicon, 456 nt in length.

Note: The allele designation for both IQCS and IQCL will always be 2 (as shown in
Figure 2) for all samples. Two alleles for each of the IQC markers are present in the
NGM Detect " Allelic Ladder (designated 1 and 2, see Figure 1). This is because the
software dictates that in order for a ladder to be valid, it must have more than one

allele per locus.

The IQC system enables you to:

¢ Confirm the success or failure of the PCR reaction, by looking for the presence or
absence of the IQCS and IQCL primer peaks on the electropherogram.

* Determine if PCR inhibitors are present in the PCR reaction, or if PCR reaction
conditions are not optimal, by comparing the relative peak heights of IQCS and
IQCL.

Evaluate the PCR reaction

To evaluate the PCR performance of the samples, review the relative peak heights of
the IQCS and IQCL. Under ideal PCR conditions, the peak height of IQCL is
approximately the same or slightly higher than IQCS (termed "balanced" in Table 3).
Under sub optimal PCR conditions (for example inhibition), the height of the IQCL is
substantially reduced relative to the ICQS. Note that when high inputs of DNA are
amplified (greater than 2 ng) some suppression of the IQC peaks may also be seen.
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See the following table for outcome scenarios.

Table 3 1QC peak interpretation

Sample DNA profile 1QC peaks Interpretation Example
Balanced Balanced PCR performance is See Figure 6
optimal, no sample
degradation or
inhibition

Ski-slope IQCL peak height Inhibition See Figure 7 and

significantly Figure 8

decreased or not
present
Ski-slope Balanced Degraded sample See Figure 9
DNA
No peaks Balanced No DNA or very little See Figure 10
sample DNA

No peaks No peaks PCR failure —

In this example of a balanced profile, the IQC peaks and the DNA profile peaks are
balanced. This indicates that PCR has occurred optimally.

o

Figure 6 Combined dyes electropherogram showing IQCS and IQCL peaks with 0.5 ng DNA
(scaled to 9,000 RFU). The IQCS peak is highlighted by the red box and the IQCL peak is
highlighted by the green box.
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Ski slope profile Figure 7 shows a significantly lower IQCL peak height relative to the IQCS peak

with decreased height. This indicates that the PCR reaction has been compromised by inhibition. If

IQCL peak height high levels of PCR inhibition occur, lower IQCL peaks exhibiting some shouldering
due to incomplete +A nucleotide addition may be observed. Figure 8 shows the
complete absence of an IQCL peak, indicating a high level of inhibition.

) - o ) - - - - -

Figure 7 Combined dyes electropherogram for the NGM Detect™ kit in the presence of 140 ng/uL humic acid. The
IQCS peak is highlighted by the red box and the IQCL peak is highlighted by the green box. The arrow indicates the ski
slope peak pattern observed in the DNA profile.

\
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Figure 8 Combined dyes electropherogram for the NGM Detect™ kit in the presence of 250 ng/uL humic acid. The
IQCS peak is highlighted by the red box and the IQCL peak is absent. The arrow indicates the ski slope peak pattern
observed in the DNA profile.
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Ski slope profile The presence of both the IQCS and IQCL with balanced relative peak heights
with balanced IQC  indicates that PCR has occurred optimally.
peaks

To00

5000

2000

WM} Aﬂm ﬂﬂﬂ L A AL [ h A |

Figure 9 Combined dyes electropherogram from degraded DNA. The IQCS peak is highlighted by the red box and the
IQCL peak is highlighted by the green box. The ski slope nature of the DNA profile is highlighted by the arrow.

No sample peaks Although there are no DNA profile peaks in the following figure, the presence of both
with balanced IQC  the IQCS and IQCL peaks with balanced relative peak heights indicates that PCR has
peaks occurred optimally.

. - - m fel = o - - -

e

s

.

=

Figure 10 Combined dyes electropherogram showing IQCS and IQCL peaks with 0 ng DNA (scaled to 2,000 RFU]J. The
IQCS peak is highlighted by the red box and the IQCL peak is highlighted by the green box.
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Importance of validation

Validation of a DNA typing procedure for human identification applications is an
evaluation of the efficiency, reliability, and performance characteristics of the
procedure. By challenging the procedure with samples that are commonly
encountered in forensic and parentage laboratories, the validation process uncovers
attributes and limitations that are critical for sound data interpretation (Sparkes,
Kimpton, Watson, 1996; Sparkes, Kimpton, Gilbard, 1996; Wallin, 1998).

Experiment conditions

56

We conducted developmental validation experiments according to the updated and
revised guidelines from the Scientific Working Group on DNA Analysis Methods
(SWGDAM, December 2016). Based on these guidelines, we conducted experiments
that comply with guidelines 2.0 and 3.0 and its associated subsections. This DNA

methodology is not novel. (Moretti et al., 2001; Frank et al., 2001; Wallin et al., 2002; and

Holt et al., 2000).

We used conditions that produced optimum PCR product yield and that met
reproducible performance standards. It is our opinion that while these experiments
are not exhaustive, they are appropriate for a manufacturer of STR kits intended for
forensic and/or parentage testing use.
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Laboratory requirements for internal validation

Each laboratory using this kit must perform internal validation studies. Performance
of this kit is supported when used according to the following developmentally
validated parameters. Modifications to the protocol should be accompanied by
appropriate validation studies performed by the laboratory.

Developmental validation

SWGDAM
guideline 2.2.1

SWGDAM
guideline 3.9.2

SWGDAM
guideline 3.9.6

Except where noted, all developmental validation studies were performed using the
GeneAmp " PCR System 9700 96-Well thermal cycler or the ProFlex " PCR System
according to the protocol described in the Perform PCR chapter.

Unless otherwise indicated, the data in this chapter are from the re-validation of the
NGM Detect " kit after redesigning the IQCL and THO1 markers. The performance of
the updated kit formulation assay is fully comparable to that of the original kit. See
the Technical Note: Updated NGM Detect™ PCR Amplification Kit: Validation and
Comparative Study for studies directly related to soil specificity and a direct
comparison of the NGM Detect" kit original formulation to the updated formulation.

“Developmental validation is the acquisition of test data and determination of
conditions and limitations of a new or novel DNA methodology for use on forensic,
database, known or casework reference samples.” (SWGDAM, December 2016)

“The reaction conditions needed to provide the required degree of specificity and
robustness should be determined. These include, but are not limited to, thermal
cycling parameters, the concentration of primers, magnesium chloride, DNA
polymerase, and other critical reagents.” (SWGDAM, December 2016)

“Criteria for detection of amplified product should be determined based on the
platform and/or method. ” (SWGDAM, December 2016)
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We examined the concentration of each component of the kit. The concentration of
each component was in the range where data indicated that the amplification met the
required performance criteria for specificity, sensitivity, and reproducibility. For
example, 0.5 ng of DNA Control 007 was amplified in the presence of varying
concentrations of magnesium chloride, and the results were analyzed on an Applied
Biosystems  3500xL Genetic Analyzer (Figure 11). The performance of the multiplex
is most robust within +20% of the optimal magnesium chloride concentration.
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Figure 11 DNA Control 007 (0.5 ng) amplified with the NGM Detect” kit in the presence of
varying concentrations of magnesium chloride and analyzed on a 3500xL Genetic Analyzer
(Y-axis scale 0 to 12,000 RFU).

Thermal cycling parameters were optimized using a Design of Experiments (DOE)
approach that seeks to identify the combination of temperatures and hold times that
produce the best assay performance. Optimal assay performance was determined
through evaluation of several factors, including; evaluation of assay sensitivity, peak-
height balance, and resistance to PCR inhibitors.

For example, annealing/extension temperatures of 57, 58, 59, 60, and 61°C were tested
using a GeneAmp' PCR System 9700 (Figure 12). The PCR products were analyzed
using a 3500xL Genetic Analyzer.
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Of the tested annealing temperatures, 57°C to 61°C produced robust profiles. The
optimal combination of specificity, sensitivity, and resistance to PCR inhibition was
observed at 59°C. Thermal cycler temperature is critical to assay performance;
therefore routine, regularly scheduled thermal cycler calibration is recommended.
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Figure 12 Electropherograms obtained from amplification of 0.5 ng of DNA Control 007 at
annealing temperatures of 57, 58, 59, 60, and 61°C, analyzed on a 3500xL Genetic Analyzer
(Y-axis scale 0 to 16,000 RFU).
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Reactions were amplified for 28, 29, 30, 31, and 32 cycles on the GemeAmpT'\1 PCR
System 9700 using 0.5 ng of DNA Control 007. As expected, the amount of PCR
product increased with the number of cycles. A full profile was generated for all
numbers of thermal cycles (28-32) and off-scale data were collected for several allele
peaks at 32 cycles (Figure 13).

We recommend using 30 cycles to optimize signal peak height and minimize artifact
or other undesirable peaks.
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Figure 13 Representative NGM Detect ™ kit profiles obtained from amplification of 0.5 ng
of DNA Control 007 using 28, 29, 30, 31, and 32 cycles, analyzed on a 3500xL Genetic
Analyzer (Y-axis scale 0 to 30,000 RFU).

Note: The data in this figure are from the original formulation of the NGM Detect” kit.

The effect of injection times on heterozygous peak heights observed for NGM Detect
assays was studied on three capillary electrophoresis instruments; the 3500 (8-
capillary), 3500xL (24-capillary), and 3130x! (16-capillary). As shown in Figure 14
through Figure 16, increasing or decreasing injection times affected profile peak
heights in an approximately linear manner. All genomic DNA samples were amplified
for 30 cycles.

Our developmental validation studies indicate that the injection conditions that are
recorded in Chapter 3 generate profiles from 0.5 ng of input DNA with heterozygous
peak height averages between 4,000-10,000 RFU (3500 or 3500xL) or 2,000—4,000 RFU
(3130 or 3130x/). This is with no instances of allelic dropout and minimal occurrence
of off-scale allele peaks. However, individual CE instrument signal intensities can
vary, therefore laboratories are encouraged to optimize injection times. Optimized
injection times provide the most efficacious level of assay sensitivity, minimize the
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occurrence of off-scale peaks or undesirable artifacts, and do not adversely impact the
performance of the size standard and allelic ladder.
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Figure 14 Box plots show the effect of varying injection times (X-axis) on peak
heterozygous heights (Y-axis) observed for NGM Detect” assays with 0.5 ng of human male
007 genomic DNA input on a 3500 Genetic Analyzer.

Note: The data in this figure are from the original formulation of the NGM Detect” kit.
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Figure 15 Box plots show the effect of varying injection times (X-axis) on heterozygous
peak heights (Y-axis) observed for NGM Detect = assays with 0.5 ng of human male 007
genomic DNA input on a 3500xL Genetic Analyzer.

Note: The data in this figure are from the original formulation of the NGM Detect” kit.

4000
C. 3130x/ (16-cap)

3500

3000

Peak Heights (RFUs)
[S]
wu
[l
(=]

2000

o0 o ofes

1500

1000
4 5 6
Time (sec)

Figure 16 Box plots show the effect of varying injection times (X-axis) on heterozygous
peak heights (Y-axis) observed for NGM Detect™ assays with 0.5 ng of human male 007
genomic DNA input on a 3130/ Genetic Analyzer.

Note: The data in this figure are from the original formulation of the NGM Detect” kit.
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Accuracy, precision, and reproducibility

SWGDAM
guideline 3.5

Accuracy
observation

“Precision and accuracy of the assay should be demonstrated: Precision characterizes
the degree of mutual agreement among a series of individual measurements, values
and/or results. Precision depends only on the distribution of random errors and does
not relate to the true value or specified value. The measure of precision is usually
expressed in terms of imprecision and computed as a standard deviation of the test
results. Accuracy is the degree of conformity of a measured quantity to its actual
(true) value. Accuracy of a measuring instrument is the ability of a measuring
instrument to give responses close to a true value.” (SWGDAM, December 2016)

Laser-induced fluorescence detection of length polymorphism at short tandem repeat
loci is not a novel methodology (Holt et al., 2000; Wallin et al., 2002). However,
accuracy and reproducibility of profiles have been determined from various sample

types.

Figure 17, Figure 18, and Figure 19 show the size differences that were observed
between sample alleles and allelic ladder alleles on the Applied Biosystems 3130 x1,
3500, and 3500xL Genetic Analyzers with POP-4" Polymer. The X-axis in the
following figures represents the nominal nucleotide sizes for the NGM Detect  Allelic
Ladder. The dashed lines parallel to the X-axis represent the +0.25-nt windows. The
y-axis represents the deviation of each sample allele size from the corresponding
Allelic Ladder allele size. All sample alleles are within +0.5 nt from a corresponding
allele in the Allelic Ladder, irrespective of the capillary electrophoresis platforms.
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Figure 17 Allele size vs. Allelic Ladder sizing for 81 samples analyzed on a 3130 x/Genetic
Analyzer. Size and ladder sizing for the NGM Detect " kit were calculated using the
GeneScan" -600 LIZ™ Size Standard v2.0.

Note: Except for the THO1 marker data, the data in this figure are from the original formulation
of the NGM Detect " kit.
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Figure 18 Allele size vs. Allelic Ladder sizing for 81 samples analyzed on a 3500 Genetic
Analyzer. Size and ladder sizing for the NGM Detect " kit were calculated using the
GeneScan"-600 LIZ" Size Standard v2.0.

Note: Except for the THOT marker data, the data in this figure are from the original formulation
of the NGM Detect " kit.
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Figure 19 Allele size vs. Allelic Ladder sizing for 81 samples analyzed on a 3500xL Genetic
Analyzer. Size and ladder sizing for the NGM Detect™ kit were calculated using the
GeneScan"'-600 LIZ" Size Standard v2.0.

Note: Except for the THO1 marker data, the data in this figure are from the original formulation
of the NGM Detect " kit.
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Sizing precision enables the determination of accurate and reliable genotypes. The
recommended method for genotyping is to use a +0.5-nt “window” around the size
obtained for each allele in the allelic ladder. A +0.5-nt window allows for the detection
and correct assignment of alleles. Any sample allele that sizes outside the specified
window could be either:

* An “off-ladder” allele, that is, an allele of a size that is not represented in the
allelic ladder.

* An allele that does correspond to an allele in the allelic ladder, but whose size is
just outside a window because of measurement error.

The measurement error inherent in any sizing method can be defined by the degree of
precision in sizing an allele multiple times. Precision is measured by calculating the
standard deviation in the size values obtained for an allele that is run in several
injections on a capillary instrument.

Table 4 lists typical precision results obtained from multiple runs of the NGM Detect -
Allelic Ladder using the GeneScan —600 LIZ" Size Standard v2.0. The results were
obtained within a set of injections on a single capillary array. The number of repeated
injections for each genetic analyzer platform is shown in the following table:

CE platform Capillaries # Injections Sizing method
3130x! 16/injection 5 Local Southern, 60-460 bp
3500 8/injection 12 Local Southern, 60-460 bp
3500xL 24/injection 4 Local Southern, 60-460 bp

The mean sizes and the standard deviation for the allele sizing were calculated for all
the alleles in each run (Table 4). The mean range and the standard deviation range
show the lowest and highest values obtained across multiple runs.

Sample alleles can occasionally size outside of the +0.5-nt window for a respective
Allelic Ladder allele because of measurement error. The frequency of such an
occurrence is lowest in detection systems with the smallest standard deviations in
sizing. The figures in “Accuracy observation” on page 63 illustrate the tight clustering
of allele sizes obtained on the Applied Biosystems  genetic analyzers, where the
standard deviation in sizing is typically less than 0.15 nt. The instance of a sample
allele sizing outside the +0.5-nt window because of measurement error is relatively
rare when the standard deviation in sizing is approximately 0.15 nt or less (Smith,
1995).

For sample alleles that do not size within a +0.5-nt window, the PCR product must be
rerun to distinguish between a true off-ladder allele versus measurement error of a
sample allele that corresponds to an allele in the Allelic Ladder. Repeat analysis, when
necessary, provides an added level of confidence in the final allele assignment.

GeneMapper  ID-X Software automatically flags sample alleles that do not size
within the prescribed window around an allelic ladder allele by labeling the allele as
OL (off-ladder).

Maximum sizing precision is obtained within the same set of capillary injections.
Cross—platform sizing differences occur due to several factors including type and
concentration of polymer, run temperature, and electrophoresis conditions. Variations
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in sizing can also occur between runs on the same instrument and between runs on
different instruments of the same platform type because of these factors.

IMPORTANT! To minimize the variation in sizing between runs and to ensure
accurate genotyping, follow the guidelines in “Allelic ladder requirements for data
analysis” on page 34 and use allelic ladders obtained from the same run as samples to
analyze the samples.

For more information on precision and genotyping, see (Lazaruk et al., 1998;
Mansfield et al., 1998).

Note: The IQCS and IQCL markers were omitted from this study because they are
not used for genotyping.
Table 4 Precision results of multiple runs of the NGM Detect™ Allelic Ladder

Note: Except for the THO1 marker data, the data in this table are from the original
formulation of the NGM Detect ™ kit.

3130x( 3500 3500xL
Allele Standard Standard Standard
Mean deviation Mean deviation Mean deviation
D2S1338
" 90.76-90.87 0.023-0.034 91.05-91.13 0.003-0.040 90.96-91.03 0.028-0.035
12 94.90-95.00 0.021-0.031 95.17-95.24 0.021-0.041 95.10-95.16 0.024-0.034
13 99.01-99.13 0.023-0.035 99.31-99.38 0.001-0.041 99.22-99.28 0.027-0.034
14 103.16-103.28 0.020-0.036 103.45-103.52 0.028-0.044 103.38-103.44 0.031-0.038
15 107.09-107.19 0.025-0.037 107.31-107.38 0.015-0.058 107.23-107.28 0.028-0.037
16 111.29-111.38 0.028-0.033 111.55-111.60 0.005-0.043 111.45-111.50 0.025-0.041
17 115.34-115.43 0.022-0.035 115.56-115.62 0.001-0.032 115.49-115.52 0.011-0.031
18 119.29-119.36 0.012-0.033 119.52-119.57 0.024-0.042 119.43-119.47 0.015-0.040
19 123.27-123.36 0.020-0.034 123.50-123.56 0.004-0.041 123.42-123.47 0.034-0.036
20 127.26-127.35 0.026-0.041 127.51-127.57 0.019-0.054 127.41-127.46 0.028-0.042
21 131.28-131.39 0.024-0.039 131.53-131.62 0.017-0.051 131.46-131.51 0.029-0.039
22 135.34-135.44 0.023-0.038 135.56-135.63 0.011-0.046 135.50-135.53 0.027-0.035
23 139.39-139.49 0.020-0.040 139.62-139.69 0.001-0.048 139.54-139.59 0.002-0.033
24 143.51-143.61 0.020-0.040 143.77-143.82 0.008-0.043 143.68-143.74 0.026-0.042
25 147.63-147.74 0.017-0.031 147.89-147.94 0.016-0.048 147.79-147.85 0.024-0.043
26 151.76-151.85 0.023-0.029 152.02-152.06 0.018-0.041 151.92-151.97 0.030-0.036
27 155.91-156.01 0.018-0.031 156.15-156.20 0.028-0.043 156.07-156.11 0.026-0.040
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3130x( 3500 3500xL
Allele Standard Standard Standard
Mean deviation Mean deviation Mean deviation
28 160.45-160.49 0.008-0.033 160.51-160.57 0.007-0.042 160.45-160.47 0.037-0.040
SE33
4.2 188.38-188.44 0.024-0.037 188.22-188.26 0.018-0.044 188.17-188.18 0.034-0.036
6.3 197.70-197.76 0.022-0.038 197.54-197.6 0.005-0.045 197.49-197.50 0.027-0.038
8 202.76-202.80 0.022-0.032 202.58-202.63 0.011-0.043 202.53-202.55 0.022-0.033
9 206.78-206.85 0.023-0.040 206.60-206.65 0.017-0.044 206.56-206.56 0.030-0.036
11 214.87-214.92 0.031-0.036 214.65-214.69 0.035-0.051 214.59-214.62 0.029-0.038
12 219.05-219.12 0.021-0.037 218.83-218.88 0.033-0.053 218.78-218.80 0.035-0.042
13 223.16-223.20 0.032-0.047 222.92-222.97 0.021-0.050 222.88-222.90 0.033-0.043
14 227.22-227.29 0.032-0.046 227.01-227.06 0.011-0.054 226.96-226.98 0.033-0.049
15 231.26-231.34 0.028-0.047 231.06-231.09 0.018-0.070 231.01-231.03 0.037-0.045
16 235.40-235.46 0.024-0.041 235.16-235.22 0.013-0.053 235.14-235.14 0.039-0.044
17 239.50-239.56 0.029-0.045 239.27-239.32 0.031-0.048 239.23-239.24 0.039-0.045
18 243.65-243.71 0.020-0.031 243.38-243.43 0.004-0.044 243.35-243.36 0.027-0.042
19 247.78-247.84 0.030-0.037 247.47-247.54 0.009-0.049 247.47-247.48 0.026-0.035
20 251.90-251.95 0.026-0.036 251.58-251.65 0.009-0.049 251.57-251.59 0.033-0.037
20.2 | 253.86-253.92 0.021-0.041 253.56-253.63 0.025-0.045 253.55-253.56 0.028-0.036
21 255.86-255.93 0.028-0.038 255.57-255.63 0.015-0.048 255.55-255.57 0.028-0.040
21.2 | 257.83-257.90 0.026-0.042 257.55-257.60 0.031-0.043 257.52-257.54 0.021-0.030
22.2 261.81-261.88 0.019-0.043 261.53-261.58 0.005-0.052 261.51-261.53 0.030-0.039
23.2 265.91-265.98 0.025-0.047 265.62-265.68 0.027-0.055 265.60-265.62 0.030-0.036
24.2 269.97-270.02 0.026-0.041 269.66-269.72 0.025-0.055 269.64-269.66 0.035-0.041
25.2 | 273.95-274.00 0.025-0.036 273.65-273.69 0.034-0.053 273.62-273.64 0.031-0.045
26.2 | 278.10-278.16 0.029-0.043 277.8-277.84 0.007-0.058 277.78-277.80 0.033-0.038
27.2 282.16-282.22 0.027-0.047 281.84-281.89 0.005-0.058 281.81-281.84 0.026-0.050
28.2 286.14-286.21 0.022-0.045 285.83-285.86 0.023-0.054 285.80-285.82 0.027-0.038
29.2 | 290.15-290.22 0.028-0.046 289.85-289.89 0.016-0.052 289.82-289.83 0.031-0.036
30.2 | 294.20-294.24 0.028-0.039 293.87-293.92 0.029-0.066 293.85-293.85 0.037-0.045
31.2 | 298.16-298.24 0.028-0.045 297.84-297.92 0.001-0.050 297.82-297.83 0.032-0.043
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Accuracy, precision, and reproducibility

3130x( 3500 3500xL
Allele Standard Standard Standard
Mean deviation Mean deviation Mean deviation
32.2 | 302.17-302.23 0.027-0.041 301.83-301.90 0.004-0.051 301.81-301.83 0.042-0.045
33.2 | 306.14-306.20 0.025-0.050 305.81-305.86 0.007-0.043 305.76-305.80 0.030-0.033
34.2 | 310.16-310.22 0.033-0.045 309.81-309.88 0.007-0.048 309.78-309.80 0.034-0.043
35 312.20-312.27 0.025-0.050 311.84-311.89 0.005-0.047 311.82-311.83 0.034-0.036
35.2 | 314.24-314.30 0.027-0.041 313.87-313.94 0.001-0.050 313.83-313.87 0.037-0.048
36 316.37-316.43 0.024-0.042 316-316.04 0.010-0.038 315.97-315.99 0.024-0.048
37 320.60-320.66 0.032-0.048 320.21-320.27 0.035-0.053 320.19-320.23 0.037-0.048
38 324.76-324.83 0.035-0.054 324.35-324.41 0.009-0.064 324.35-324.38 0.042-0.048
39 328.85-328.92 0.027-0.047 328.45-328.51 0.029-0.055 328.45-328.48 0.029-0.039
42 341.00-341.06 0.031-0.048 340.58-340.65 0.001-0.064 340.57-340.59 0.037-0.044
D16S539
5 72.32-72.38 0.032-0.041 72.00-72.05 0.009-0.051 71.93-71.98 0.024-0.031
8 84.95-84.99 0.024-0.040 84.64-84.70 0.008-0.044 84.58-84.61 0.027-0.040
9 89.15-89.18 0.020-0.034 88.84-88.9 0.004-0.045 88.78-88.82 0.027-0.041
10 93.30-93.33 0.022-0.036 92.99-93.05 0.004-0.040 92.94-92.97 0.028-0.040
11 97.45-97.49 0.020-0.039 97.15-97.22 0.007-0.045 97.11-97.14 0.025-0.035
12 101.63-101.67 0.026-0.033 101.33-101.39 0.030-0.046 101.28-101.33 0.034-0.039
13 105.83-105.86 0.021-0.043 105.53-105.59 0.009-0.047 105.47-105.52 0.038-0.039
14 109.97-110.01 0.027-0.042 109.66-109.74 0.032-0.048 109.63-109.67 0.030-0.043
15 114.08-114.11 0.024-0.036 113.77-113.85 0.028-0.051 113.72-113.78 0.027-0.038
D18S51
7 127.11-127.18 0.030-0.038 127.52-127.58 0.014-0.046 127.44-127.47 0.028-0.042
9 134.69-134.79 0.022-0.047 135.21-135.27 0.010-0.051 135.12-135.17 0.028-0.045
10 138.52-138.63 0.025-0.051 139.07-139.15 0.001-0.041 139.00-139.06 0.037-0.042
10.2 140.66-140.77 0.028-0.054 141.21-141.30 0.001-0.042 141.15-141.21 0.035-0.043
" 142.41-142.53 0.023-0.047 143.00-143.10 0.008-0.052 142.93-142.99 0.020-0.038
12 146.33-146.45 0.023-0.050 146.95-147.03 0.020-0.044 146.88-146.95 0.029-0.038
13 150.27-150.39 0.027-0.042 150.90-151.01 0.024-0.045 150.83-150.91 0.031-0.038
13.2 152.41-152.53 0.027-0.050 153.05-153.16 0.013-0.046 153.00-153.07 0.033-0.044
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PO
]

Accuracy, precision, and reproducibility L0
3130x( 3500 3500xL
Allele Standard Standard Standard
Mean deviation Mean deviation Mean deviation
14 154.21-154.33 0.030-0.048 154.86-154.96 0.024-0.046 154.80-154.87 0.032-0.036
14.2 156.35-156.48 0.021-0.040 157.02-157.14 0.004-0.047 156.96-157.03 0.035-0.043
15 158.15-158.27 0.032-0.051 158.83-158.94 0.001-0.043 158.76-158.83 0.040-0.045
16 162.05-162.18 0.027-0.049 162.76-162.86 0.004-0.043 162.69-162.77 0.030-0.037
17 165.92-166.07 0.027-0.054 166.64-166.77 0.003-0.039 166.58-166.66 0.029-0.046
18 169.80-169.93 0.034-0.049 170.54-170.66 0.016-0.044 170.49-170.57 0.030-0.039
19 173.66-173.81 0.031-0.049 174.44-174.55 0.004-0.044 174.39-174.47 0.029-0.045
20 177.54-177.69 0.035-0.051 178.34-178.48 0.003-0.047 178.28-178.36 0.032-0.040
21 181.47-181.63 0.039-0.049 182.30-182.45 0.006-0.044 182.26-182.35 0.035-0.044
22 185.33-185.52 0.035-0.047 186.21-186.37 0.013-0.042 186.17-186.26 0.033-0.046
23 189.25-189.44 0.030-0.067 190.17-190.32 0.022-0.046 190.12-190.22 0.032-0.042
24 193.19-193.37 0.032-0.054 194.13-194.26 0.021-0.050 194.07-194.17 0.029-0.055
25 197.14-197.32 0.030-0.064 198.11-198.25 0.005-0.048 198.05-198.15 0.033-0.047
26 200.98-201.15 0.038-0.065 201.92-202.07 0.024-0.048 201.88-201.98 0.034-0.043
27 204.81-204.98 0.035-0.067 205.76-205.91 0.020-0.040 205.72-205.83 0.038-0.046
THO1

4 222.50-222.65 0.035-0.073 223.26-223.39 0.004-0.049 223.19-223.31 0.035-0.041

5 226.48-226.64 0.029-0.076 227.24-227.39 0.011-0.060 227.19-227.32 0.031-0.040

6 230.47-230.65 0.034-0.057 231.25-231.39 0.029-0.049 231.19-231.31 0.027-0.044

7 234.46-234.65 0.028-0.059 235.27-235.39 0.008-0.048 235.18-235.31 0.033-0.041

8 238.47-238.65 0.033-0.068 239.25-239.40 0.005-0.050 239.19-239.32 0.029-0.043

9 242.55-242.71 0.028-0.065 243.34-243.47 0.027-0.053 243.26-243.38 0.025-0.040
9.3 245.61-245.78 0.035-0.058 246.38-246.51 0.005-0.049 246.31-246.43 0.034-0.047
10 246.63-246.81 0.033-0.074 247.40-247.54 0.024-0.050 247.33-247.45 0.031-0.041
11 250.70-250.86 0.036-0.066 251.43-251.54 0.003-0.046 251.36-251.47 0.034-0.043
12 254.62-254.79 0.031-0.069 255.36-255.48 0.016-0.046 255.29-255.40 0.030-0.044
13 258.53-258.71 0.036-0.063 259.28-259.39 0.003-0.045 259.19-259.31 0.033-0.040
13.3 | 261.46-261.65 0.042-0.065 262.21-262.34 0.005-0.038 262.15-262.27 0.027-0.042
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3130x( 3500 3500xL
Allele Standard Standard Standard
Mean deviation Mean deviation Mean deviation
D12S391
14 281.70-281.76 0.022-0.037 281.71-281.75 0.039-0.054 281.68-281.70 0.033-0.041
15 285.72-285.76 0.026-0.033 285.73-285.75 0.010-0.048 285.69-285.71 0.030-0.043
16 289.68-289.72 0.023-0.040 289.68-289.71 0.001-0.049 289.65-289.67 0.030-0.038
17 293.71-293.77 0.018-0.037 293.71-293.76 0.001-0.046 293.68-293.69 0.027-0.041
18 297.70-297.75 0.026-0.040 297.7-297.74 0.001-0.050 297.67-297.69 0.036-0.040
19 301.69-301.74 0.020-0.042 301.70-301.75 0.024-0.048 301.65-301.67 0.032-0.040
19.3 | 304.64-304.68 0.021-0.033 304.62-304.67 0.011-0.047 304.58-304.61 0.031-0.037
20 305.62-305.66 0.025-0.037 305.61-305.65 0.007-0.048 305.56-305.59 0.030-0.039
21 309.65-309.70 0.022-0.043 309.65-309.71 0.012-0.054 309.60-309.64 0.036-0.044
22 313.76-313.81 0.028-0.041 313.77-313.79 0.031-0.050 313.71-313.74 0.034-0.040
23 318.00-318.04 0.022-0.037 317.97-318.00 0.032-0.051 317.92-317.96 0.026-0.039
24 322.19-322.22 0.026-0.046 322.13-322.18 0.004-0.056 322.11-322.13 0.016-0.047
25 326.3-326.33 0.022-0.041 326.24-326.28 0.011-0.070 326.21-326.23 0.034-0.052
26 330.39-330.42 0.027-0.033 330.34-330.38 0.029-0.067 330.31-330.34 0.037-0.048
27 334.42-334.46 0.025-0.039 334.38-334.40 0.016-0.060 334.34-334.38 0.027-0.042
D3S1358
9 112.46-112.49 0.019-0.047 112.54-112.59 0.038-0.046 112.50-112.53 0.017-0.035
10 116.39-116.42 0.021-0.027 116.47-116.51 0.001-0.036 116.43-116.45 0.024-0.032
11 120.26-120.29 0.018-0.035 120.33-120.37 0.028-0.044 120.29-120.30 0.022-0.037
12 124.05-124.08 0.023-0.034 124.11-124.15 0.007-0.049 124.08-124.09 0.023-0.044
13 128.11-128.15 0.024-0.038 128.17-128.22 0.025-0.049 128.14-128.15 0.031-0.037
14 132.04-132.09 0.016-0.035 132.12-132.16 0.026-0.050 132.09-132.10 0.029-0.038
15 135.93-135.96 0.024-0.034 136.01-136.04 0.006-0.037 135.98-135.98 0.030-0.035
16 140.07-140.11 0.017-0.035 140.16-140.20 0.001-0.046 140.13-140.13 0.039-0.043
17 144.27-144.29 0.020-0.036 144.33-144.37 0.034-0.052 144.31-144.32 0.027-0.037
18 148.33-148.36 0.017-0.031 148.4-148.44 0.029-0.049 148.38-148.38 0.028-0.033
19 152.35-152.37 0.019-0.030 152.40-152.45 0.027-0.045 152.38-152.39 0.032-0.039
20 156.66-156.70 0.023-0.037 156.70-156.76 0.008-0.038 156.69-156.71 0.020-0.037
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Accuracy, precision, and reproducibility L0
3130x( 3500 3500xL
Allele Standard Standard Standard
Mean deviation Mean deviation Mean deviation
FGA
13 165.50-165.58 0.029-0.039 165.95-166.04 0.015-0.047 165.93-165.97 0.023-0.040
14 169.35-169.45 0.030-0.036 169.84-169.91 0.003-0.043 169.81-169.86 0.030-0.035
15 173.21-173.31 0.031-0.039 173.72-173.83 0.009-0.043 173.70-173.74 0.028-0.038
16 177.06-177.17 0.032-0.041 177.59-177.71 0.004-0.047 177.58-177.63 0.031-0.041
17 180.94-181.05 0.026-0.042 181.51-181.61 0.005-0.047 181.48-181.55 0.027-0.047
18 184.85-184.97 0.032-0.045 185.45-185.56 0.013-0.051 185.43-185.50 0.030-0.039
19 188.76-188.89 0.024-0.040 189.38-189.51 0.021-0.039 189.38-189.45 0.031-0.042
20 192.67-192.80 0.032-0.042 193.34-193.44 0.010-0.049 193.31-193.39 0.028-0.049
21 196.56-196.70 0.030-0.050 197.23-197.38 0.004-0.046 197.24-197.32 0.035-0.043
22 200.46-200.59 0.034-0.054 201.15-201.27 0.027-0.054 201.13-201.22 0.026-0.043
23 204.28-204.39 0.033-0.049 204.97-205.11 0.020-0.044 204.96-205.05 0.031-0.050
24 208.09-208.22 0.037-0.048 208.83-208.93 0.011-0.056 208.81-208.89 0.035-0.048
25 211.94-212.05 0.027-0.048 212.67-212.82 0.004-0.048 212.67-212.74 0.039-0.050
26 215.83-215.95 0.029-0.061 216.58-216.74 0.023-0.041 216.59-216.69 0.037-0.043
27 219.83-219.97 0.034-0.059 220.62-220.79 0.001-0.050 220.64-220.73 0.036-0.050
28 223.71-223.86 0.035-0.058 224.55-224.68 0.011-0.053 224.54-224.64 0.037-0.040
29 227.55-227.70 0.034-0.063 228.41-228.58 0.016-0.061 228.43-228.53 0.030-0.056
30 231.34-231.50 0.034-0.056 232.23-232.40 0.015-0.057 232.25-232.36 0.035-0.056
30.2 233.71-233.86 0.030-0.054 234.60-234.76 0.014-0.050 234.62-234.73 0.039-0.052
31.2 237.59-237.74 0.029-0.062 238.50-238.68 0.003-0.050 238.52-238.64 0.040-0.051
32.2 241.50-241.66 0.038-0.053 242.46-242.62 0.034-0.050 242.47-242.59 0.038-0.047
33.2 | 245.48-245.64 0.035-0.049 246.43-246.61 0.022-0.053 246.47-246.56 0.041-0.052
42.2 | 280.49-280.68 0.034-0.067 281.59-281.80 0.001-0.048 281.61-281.75 0.038-0.052
43.2 284.32-284.52 0.041-0.073 285.46-285.67 0.016-0.047 285.47-285.62 0.032-0.052
442 288.33-288.51 0.041-0.070 289.46-289.66 0.016-0.053 289.48-289.62 0.033-0.055
45.2 | 292.23-292.41 0.040-0.070 293.35-293.57 0.001-0.055 293.38-293.52 0.033-0.048
46.2 | 295.73-295.93 0.037-0.065 296.95-297.17 0.004-0.051 296.98-297.12 0.038-0.059
47.2 299.50-299.7 0.037-0.073 300.72-300.95 0.007-0.059 300.76-300.90 0.036-0.065
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Allele Standard Standard Standard

e deviation e deviation e deviation

48.2 303.40-303.60 0.034-0.075 304.64-304.87 0.018-0.053 304.67-304.82 0.040-0.055

50.2 311.14-311.37 0.048-0.081 312.47-312.69 0.007-0.063 312.46-312.64 0.043-0.057

51.2 314.87-315.12 0.052-0.083 316.30-316.56 0.021-0.066 316.34-316.51 0.039-0.055

Yindel
1 90.97-91.00 0.021-0.031 91.04-91.10 0.028-0.044 90.97-90.98 0.030-0.033
2 96.09-96.12 0.022-0.033 96.18-96.22 0.001-0.035 96.10-96.11 0.022-0.035
AMEL

X 108.18-108.22 0.024-0.039 108.08-108.16 0.007-0.046 108.05-108.09 0.030-0.035

Y 113.96-114.01 0.001-0.035 113.94-113.99 0.028-0.042 113.91-113.94 0.025-0.035

VWA

1 125.73-125.77 0.017-0.040 125.79-125.85 0.015-0.046 125.74-125.78 0.024-0.038

12 129.63-129.66 0.021-0.036 129.72-129.76 0.026-0.046 129.67-129.69 0.026-0.036

13 133.62-133.65 0.023-0.039 133.74-133.75 0.017-0.050 133.67-133.70 0.031-0.036

14 137.82-137.86 0.021-0.035 137.96-137.99 0.004-0.045 137.92-137.93 0.025-0.040

15 141.72-141.75 0.024-0.036 141.87-141.90 0.005-0.045 141.81-141.83 0.025-0.030

16 145.81-145.83 0.022-0.035 145.96-146.01 0.026-0.043 145.92-145.93 0.027-0.036

17 149.88-149.92 0.024-0.035 150.05-150.10 0.028-0.042 150.02-150.03 0.034-0.040

18 153.94-153.97 0.027-0.035 154.12-154.16 0.021-0.046 154.07-154.08 0.028-0.040

19 158.03-158.07 0.023-0.040 158.23-158.27 0.004-0.046 158.18-158.20 0.031-0.038

20 162.08-162.13 0.022-0.048 162.29-162.32 0.024-0.045 162.24-162.27 0.023-0.037

21 166.07-166.11 0.024-0.033 166.26-166.33 0.026-0.045 166.24-166.25 0.022-0.038

22 170.08-170.11 0.016-0.036 170.29-170.34 0.020-0.041 170.25-170.27 0.032-0.035

23 173.97-174.03 0.020-0.032 174.20-174.26 0.010-0.047 174.17-174.18 0.031-0.039

24 178.37-178.42 0.029-0.037 178.59-178.64 0.003-0.046 178.56-178.57 0.029-0.038

D21511

24 197.75-197.85 0.024-0.039 198.20-198.26 0.032-0.046 198.16-198.20 0.034-0.045

24.2 199.77-199.87 0.033-0.040 200.23-200.30 0.001-0.046 200.19-200.24 0.023-0.042

25 201.76-201.85 0.023-0.045 202.20-202.25 0.031-0.043 202.16-202.2 0.027-0.035

26 205.74-205.81 0.020-0.046 206.16-206.22 0.024-0.050 206.12-206.16 0.031-0.044
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Accuracy, precision, and reproducibility L0
3130x( 3500 3500xL
Allele Standard Standard Standard
Mean deviation Mean deviation Mean deviation
27 209.74-209.81 0.025-0.043 210.16-210.23 0.031-0.047 210.12-210.17 0.037-0.046
28 213.69-213.75 0.025-0.037 214.11-214.16 0.031-0.048 214.08-214.11 0.025-0.042
28.2 215.69-215.75 0.029-0.044 216.11-216.19 0.025-0.046 216.09-216.13 0.028-0.040
29 217.69-217.77 0.024-0.032 218.13-218.22 0.025-0.045 218.13-218.16 0.029-0.042
29.2 | 219.81-219.88 0.027-0.045 220.23-220.31 0.001-0.049 220.22-220.26 0.030-0.041
30 221.77-221.86 0.024-0.037 222.23-222.3 0.005-0.043 222.21-222.25 0.032-0.047
30.2 223.77-223.84 0.027-0.045 224.20-224.29 0.008-0.056 224.20-224.24 0.034-0.045
31 225.78-225.86 0.027-0.049 226.26-226.32 0.021-0.059 226.24-226.28 0.038-0.043
31.2 | 227.76-227.85 0.030-0.041 228.23-228.32 0.011-0.054 228.21-228.28 0.037-0.039
32 229.78-229.86 0.033-0.047 230.28-230.35 0.022-0.056 230.26-230.31 0.038-0.043
32.2 231.76-231.86 0.030-0.049 232.27-232.34 0.019-0.055 232.25-232.29 0.027-0.042
33 233.79-233.89 0.027-0.043 234.28-234.38 0.009-0.048 234.28-234.33 0.036-0.038
33.2 | 235.74-235.83 0.031-0.043 236.27-236.33 0.011-0.046 236.23-236.29 0.037-0.040
34 237.87-237.98 0.023-0.040 238.38-238.47 0.007-0.048 238.38-238.42 0.017-0.043
34.2 | 239.80-239.89 0.036-0.041 240.33-240.40 0.001-0.048 240.30-240.37 0.033-0.044
35 241.92-242.02 0.029-0.044 242.46-242.54 0.030-0.052 242.43-242.49 0.036-0.041
35.2 243.92-244.00 0.029-0.038 244.43-244.51 0.024-0.053 244.61-244.47 0.028-0.041
36 245.94-246.05 0.025-0.037 246.46-246.55 0.004-0.048 246.46-246.49 0.033-0.040
37 250.09-250.18 0.032-0.039 250.59-250.67 0.001-0.046 250.58-250.63 0.028-0.040
38 253.95-254.05 0.024-0.044 254.46-254.53 0.018-0.048 254.45-254.51 0.028-0.043
D1S1656
9 267.24-267.33 0.029-0.037 267.69-267.75 0.019-0.049 267.64-267.68 0.035-0.040
10 271.29-271.37 0.027-0.034 271.71-271.79 0.021-0.047 271.67-271.72 0.035-0.037
11 275.31-275.40 0.026-0.041 275.76-275.82 0.010-0.048 275.70-275.76 0.031-0.040
12 279.35-279.42 0.021-0.039 279.76-279.83 0.001-0.049 279.71-279.76 0.035-0.046
13 283.38-283.45 0.017-0.043 283.80-283.86 0.001-0.051 283.73-283.79 0.031-0.039
14 287.35-287.40 0.022-0.035 287.75-287.82 0.005-0.037 287.70-287.74 0.030-0.041
14.3 | 290.42-290.48 0.027-0.040 290.80-290.86 0.013-0.055 290.75-290.81 0.038-0.047
15 291.31-291.37 0.018-0.037 291.72-291.79 0.005-0.050 291.67-291.72 0.031-0.040
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Allele Standard Standard Standard
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15.3 294.41-294.45 0.025-0.037 294.80-294.85 0.010-0.050 294.74-294.78 0.035-0.047

16 295.31-295.38 0.020-0.038 295.75-295.80 0.008-0.048 295.66-295.72 0.033-0.039

16.3 298.41-298.45 0.029-0.036 298.78-298.84 0.031-0.049 298.71-298.76 0.038-0.045

17 299.24-299.29 0.022-0.043 299.64-299.72 0.001-0.052 299.56-299.61 0.018-0.044

17.3 302.34-302.39 0.028-0.040 302.71-302.77 0.023-0.052 302.64-302.69 0.023-0.042

18 303.19-303.24 0.021-0.037 303.62-303.65 0.007-0.047 303.53-303.58 0.030-0.036

18.3 306.24-306.32 0.024-0.040 306.66-306.70 0.018-0.048 306.57-306.64 0.026-0.048

19.3 310.25-310.32 0.026-0.044 310.65-310.70 0.007-0.057 310.57-310.63 0.029-0.036

20.3 314.22-314.30 0.008-0.041 314.65-314.71 0.001-0.048 314.56-314.62 0.018-0.045

D2S441

8 334.96-335.09 0.033-0.047 335.78-335.91 0.031-0.050 335.70-335.84 0.027-0.045

9 338.84-338.99 0.035-0.049 339.68-339.78 0.031-0.053 339.57-339.71 0.018-0.053

10 342.87-343.01 0.029-0.049 343.71-343.87 0.032-0.054 343.64-343.78 0.035-0.047

" 346.91-347.05 0.035-0.046 347.80-347.91 0.016-0.056 347.68-347.82 0.030-0.049

11.3 349.92-350.06 0.032-0.061 350.83-350.96 0.016-0.049 350.72-350.87 0.026-0.054

12 351.00-351.15 0.026-0.054 351.91-352.03 0.021-0.055 351.80-351.94 0.035-0.053

13 354.97-355.12 0.032-0.051 355.88-356.01 0.010-0.050 355.78-355.94 0.027-0.047

14 358.95-359.10 0.036-0.056 359.88-360 0.001-0.053 359.78-359.90 0.037-0.048

15 362.94-363.09 0.040-0.058 363.86-363.99 0.010-0.051 363.77-363.92 0.040-0.044

16 366.93-367.07 0.037-0.049 367.83-367.97 0.024-0.051 367.77-367.91 0.033-0.039

17 370.94-371.08 0.030-0.051 371.86-372.01 0.035-0.049 371.79-371.94 0.032-0.043

D8S1179
5 95.58-95.63 0.025-0.030 95.79-95.84 0.027-0.045 95.73-95.76 0.025-0.035
6 99.66-99.71 0.016-0.032 99.88-99.92 0.001-0.042 99.83-99.84 0.016-0.034

7 103.81-103.86 0.023-0.033 104.04-104.09 0.010-0.047 103.98-104.01 0.028-0.036

8 107.91-107.96 0.023-0.037 108.15-108.19 0.007-0.044 108.09-108.10 0.033-0.042

9 111.97-112.02 0.017-0.034 112.21-112.26 0.007-0.045 112.17-112.18 0.025-0.035

10 115.96-116.00 0.017-0.033 116.19-116.24 0.001-0.039 116.15-116.16 0.019-0.026

" 119.87-119.91 0.024-0.031 120.12-120.16 0.001-0.051 120.07-120.08 0.014-0.024
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Accuracy, precision, and reproducibility L0
3130x( 3500 3500xL
Allele Standard Standard Standard
Mean deviation Mean deviation Mean deviation
12 123.91-123.96 0.027-0.033 124.17-124.22 0.007-0.052 124.13-124.15 0.026-0.040
13 127.72-127.79 0.022-0.038 128.01-128.06 0.021-0.043 127.96-127.98 0.030-0.041
14 131.64-131.70 0.021-0.038 131.94-132.00 0.019-0.050 131.91-131.93 0.031-0.041
15 135.62-135.69 0.024-0.040 135.95-136.00 0.033-0.046 135.90-135.93 0.023-0.036
16 139.62-139.69 0.031-0.037 139.95-140.01 0.001-0.041 139.92-139.94 0.023-0.038
17 143.71-143.78 0.018-0.043 144.08-144.14 0.010-0.044 144.04-144.08 0.029-0.040
18 147.81-147.88 0.028-0.039 148.19-148.24 0.020-0.042 148.14-148.18 0.033-0.039
19 151.93-152.01 0.024-0.038 152.31-152.37 0.018-0.048 152.27-152.30 0.031-0.042
D19S433
6 172.80-172.89 0.025-0.039 173.29-173.39 0.013-0.043 173.28-173.33 0.028-0.034
7 176.77-176.85 0.030-0.038 177.25-177.35 0.003-0.047 177.25-177.30 0.035-0.042
8 180.72-180.82 0.028-0.042 181.25-181.35 0.004-0.047 181.25-181.30 0.023-0.040
9 184.79-184.92 0.019-0.043 185.37-185.47 0.013-0.045 185.37-185.44 0.031-0.040
10 188.80-188.92 0.028-0.043 189.42-189.51 0.021-0.042 189.40-189.47 0.035-0.042
11 192.70-192.81 0.023-0.047 193.33-193.42 0.010-0.053 193.31-193.39 0.028-0.045
12 196.67-196.79 0.033-0.044 197.32-197.44 0.007-0.045 197.32-197.40 0.029-0.046
12.2 198.81-198.94 0.025-0.046 199.44-199.56 0.001-0.046 199.46-199.53 0.038-0.048
13 200.64-200.75 0.035-0.043 201.28-201.40 0.005-0.043 201.28-201.36 0.028-0.048
13.2 | 202.61-202.71 0.030-0.045 203.26-203.36 0.010-0.045 203.26-203.33 0.027-0.043
14 204.53-204.64 0.033-0.045 205.19-205.29 0.016-0.052 205.19-205.26 0.037-0.040
14.2 206.51-206.62 0.023-0.047 207.17-207.27 0.019-0.052 207.16-207.23 0.029-0.043
15 208.44-208.54 0.031-0.048 209.11-209.21 0.008-0.050 209.10-209.18 0.028-0.046
15.2 | 210.41-210.50 0.029-0.050 211.08-211.19 0.009-0.050 211.09-211.16 0.020-0.044
16 212.36-212.45 0.027-0.051 213.03-213.13 0.003-0.048 213.03-213.11 0.037-0.039
16.2 214.34-214.43 0.032-0.047 215.03-215.14 0.031-0.048 215.03-215.11 0.032-0.045
17 216.42-216.52 0.033-0.048 217.12-217.25 0.023-0.046 217.15-217.23 0.029-0.044
17.2 218.34-218.44 0.027-0.049 219.05-219.19 0.003-0.062 219.07-219.15 0.035-0.048
18.2 | 222.38-222.48 0.031-0.044 223.12-223.25 0.017-0.054 223.14-223.22 0.036-0.055
19.2 | 226.31-226.42 0.036-0.057 227.06-227.22 0.015-0.061 227.11-227.19 0.034-0.052
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3130x( 3500 3500xL
Allele Standard Standard Standard
Mean deviation Mean deviation Mean deviation

D22S1045
7 245.00-245.10 0.024-0.044 245.61-245.70 0.003-0.051 245.59-245.66 0.031-0.041
8 248.05-248.14 0.026-0.041 248.65-248.74 0.007-0.053 248.63-248.69 0.039-0.045
9 251.04-251.15 0.025-0.042 251.63-251.71 0.035-0.046 251.61-251.67 0.022-0.034
10 253.99-254.08 0.021-0.035 254.56-254.66 0.014-0.044 254.55-254.61 0.032-0.040
11 256.91-257.00 0.031-0.047 257.50-257.58 0.001-0.043 257.47-257.53 0.030-0.035
12 259.81-259.90 0.034-0.046 260.43-260.52 0.031-0.050 260.40-260.47 0.039-0.044
13 262.79-262.89 0.031-0.057 263.39-263.51 0.026-0.046 263.38-263.45 0.031-0.039
14 265.76-265.87 0.031-0.059 266.41-266.49 0.013-0.040 266.36-266.44 0.030-0.049
15 268.74-268.85 0.032-0.044 269.36-269.47 0.020-0.059 269.35-269.42 0.027-0.034
16 271.74-271.85 0.029-0.040 272.36-272.46 0.030-0.046 272.33-272.41 0.032-0.037
17 274.73-274.83 0.028-0.048 275.35-275.45 0.012-0.056 275.33-275.40 0.033-0.042
18 277.73-277.83 0.026-0.043 278.36-278.47 0.030-0.050 278.33-278.41 0.034-0.043
19 280.71-280.81 0.015-0.049 281.34-281.45 0.029-0.049 281.31-281.39 0.033-0.042
20 283.70-283.78 0.027-0.037 284.32-284.42 0.001-0.048 284.28-284.37 0.026-0.048

D10S1248
8 303.34-303.37 0.021-0.039 303.46-303.49 0.012-0.049 303.42-303.45 0.031-0.040
9 307.25-307.29 0.021-0.036 307.39-307.43 0.010-0.049 307.33-307.37 0.031-0.042
10 311.24-311.27 0.027-0.039 311.37-311.40 0.005-0.046 311.30-311.35 0.030-0.045
11 315.30-315.33 0.024-0.042 315.42-315.46 0.024-0.050 315.38-315.41 0.034-0.048
12 319.51-319.53 0.022-0.040 319.60-319.64 0.035-0.053 319.58-319.6 0.019-0.044
13 323.62-323.63 0.021-0.042 323.67-323.72 0.007-0.064 323.65-323.69 0.030-0.045
14 327.67-327.68 0.028-0.039 327.73-327.76 0.016-0.053 327.70-327.73 0.033-0.042
15 331.70-331.71 0.024-0.037 331.74-331.80 0.023-0.048 331.72-331.76 0.030-0.043
16 335.70-335.72 0.022-0.039 335.76-335.79 0.012-0.049 335.74-335.76 0.030-0.046
17 339.68-339.69 0.019-0.032 339.73-339.78 0.041-0.053 339.71-339.73 0.031-0.038
18 343.71-343.74 0.023-0.038 343.76-343.8 0.011-0.048 343.74-343.77 0.030-0.036
19 347.76-347.78 0.012-0.035 347.80-347.85 0.014-0.049 347.78-347.81 0.032-0.038
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Extra peaks in the electropherogram

Extra peaks in the electropherogram

Causes of extra
peaks

Extra peaks:
Stutter

Peaks other than the target alleles may be detected on the electropherogram. Causes
for the appearance of extra peaks include stutter products, incomplete 3" A nucleotide
addition (at the n-1 position), dye artifacts, and mixed DNA samples (see DNA
Advisory Board (DAB) Standard 8.1.2.2).

Stutter definition

Stutter is a well-characterized PCR artifact that refers to the appearance of a minor
peak one repeat unit smaller than the target STR allele product (minus stutter), or less
frequently, one repeat larger (plus stutter) (Butler, 2005; Mulero et al., 2006). Sequence
analysis of stutter products at tetranucleotide STR loci has revealed that the minus
stutter product is missing a single tetranucleotide core repeat unit relative to the main
allele (Walsh et al., 1996). Although plus-stutter is normally much less significant than
minus-stutter in STR loci with tetranucleotide repeats, the incidence of plus-stutter
may be more significant in trinucleotide repeat-containing loci.

Contact HID Support for more information on plus stutter.

The proportion of the stutter product relative to the main allele (percent stutter) is
measured by dividing the height of the stutter peak by the height of the main allele
peak.

Stutter observations

Plus-stutter was regularly observed and was more significant in trinucleotide repeat-
containing loci (Figure 25 on page 83).

Peak heights were measured for amplified samples at the loci that are used in the kit.
All data were generated on the 3500xL Genetic Analyzer. Some conclusions from
these measurements and observations are:

* For each locus, the stutter percentage generally increases with allele length.

¢ Each allele within a locus displays a relatively consistent average stutter
percentage.

* Peaks in the stutter position that are above the stutter filter percentage specified
in the software are not filtered.

¢ The measurement of stutter percentage for allele peaks that are off-scale may be
unusually high due to artificial truncation of the main allele peak.

e Stutter can be elevated when minus stutter and plus stutter overlap. This is
typically observed when a given allele flanks another allele that is 2 repeat units
away (as seen with the FGA locus in control 007 DNA).

¢ The magnitude and/or variability of stutter may increase with low DNA input
amounts.

Figure 20 through Figure 24 show the stutter observed in the population study that
are one repeat unit away from the alleles recorded. All data were generated on the
3500xL Genetic Analyzer.
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The stutter filter settings that are derived from this data are listed in “Stutter
percentage filter settings provided with GeneMapper™ ID-X Software” on page 83.
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Figure 20 Stutter percentages for D151656, D2S441, D251338, and D3S1358 loci
(Blue=FAM™ dye, black=TED"™ dye, red=TAZ"™ dye)

Note: The data in this figure are from the original formulation of the NGM Detect™ kit.
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Figure 21 Stutter percentages for D851179, D10S1248, D12S391, and D165539
(Green=VIC™ dye and purple=SID™ dye)

Note: The data in this figure are from the original formulation of the NGM Detect™ kit.
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Figure 22 Stutter percentages for D18551, D195433, and D21511 loci (Green=vIC™ dye,

red=TAZ" dye, purple=SID™ dye)

Note: The data in this figure are from the original formulation of the NGM Detect™ kit.
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Figure 23 Stutter percentages for D2251045, THO1, and FGA loci (Purple=SID™ dye,
Green=VIC™ dye, black=TED™ dye)

Note: Except for the THO1 marker data, the data in this figure are from the original formulation

of the NGM Detect™ k
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Figure 24 Stutter percentages for SE33 and VWA loci (Blue=FAM™ dye, red=TAZ™ dye)
Note: The data in this figure are from the original formulation of the NGM Detect™ kit.
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Non-standard stutter peaks at the D2251045 and SE33 loci

The D2251045 locus in the NGM Detect " kit is a trinucleotide repeat locus, and shows
an elevated level of plus stutter (Figure 25). Other loci, such as THO1 and D251338,
may also exhibit relatively elevated plus stutter.

nnnnnn i

Main allele peak

Minus stutter
Plus stutter

[&] @]

Figure 25 NGM Detect™ kit electropherogram showing minus and plus stutter associated
with the D2251045 STR locus. Data produced on a 3500xL Genetic Analyzer.

Note: The data in this figure are from the original formulation of the NGM Detect™ kit.

STR loci such as D151656 and SE33 (Figure 26) contain more complex nucleotide
sequences including regions of dinucleotide repeats which can yield additional stutter
peaks. If these stutter peaks exceed the peak amplitude threshold (typically 175 RFU),
they may be detected as additional alleles in the profile. The stutter file that is
provided with the GeneMapper™ ID-X Software for analysis of NGM Detect " kit data
contains a minus 2—nt stutter filter for SE33 and D151656, as well as filters for
commonly observed plus stutter, to prevent these peaks from being called in normal
profiles.

Main allele peak

-2 nt stutter

-4 nt stutter

B

Figure 26 Example of a -2-nt reproducible stutter artifact at the SE33 locus. Data
produced on a 3500xL Genetic Analyzer.

Note: The data in this figure are from the original formulation of the NGM Detect™ kit.

Stutter percentage filter settings provided with GeneMapper™ /D-XSoftware

The settings in Table 5 and Table 6 were derived using the data that is shown in
“Stutter observations” on page 77. The proportion of the stutter product relative to the
main allele (stutter percent) is measured by dividing the height of the stutter peak by
the height of the main allele peak.
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Analysis showed that observed stutter data points were not normally distributed. As
such, at each locus a best-fit, non-parametric statistical model was applied to the data
and a threshold filter level that emulated historical stutter filter levels (approximately
99.7%) was derived.

IMPORTANT! The values that are shown in the table are the values that were
determined during developmental validation studies using specific data sets. To
determine the appropriate values to use for your applications, always perform
internal validation studies.

Table 5 Minus stutter percentage filter settings provided with the GeneMapper™ /D-X
Software

Note: The data in this table are from the original validation study of the NGM Detect™ kit.
Based on the validation study with the updated kit formulation, no changes to the stutter
filter values were required.

Locus [ % Stutter
D251338 17.61
SE33 18.63
SE33 (-2 nt) 6.41
D165539 11.97
D18S51 16.15
THO1 7.66
D125391 18.99
D351358 15.42
FGA 14.70
vWA 12.51
D21511 16.88
D151656 16.68
D151656 (-2 nt) 3.90
D2S441 9.55
D8S1179 13.80
D195433 13.57
D2251045 19.02
D10S1248 14.32

' These percentages are used as stutter filters in NGM_Detect_Stutter.txt
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Table 6 Plus stutter percentage filter settings provided with the GeneMapper™ /0-X

Software

Note: The data in this table are from the original validation study of the NGM Detect™ kit.
Based on the validation study with the updated kit formulation, no changes to the stutter

filter values were required.
Locus [ % Stutter
D251338 11.55
SE33 9.80
D165S539 4.68
D18S51 8.19
THO1 6.14
D125391 7.76
D351358 4.36
FGA 9.16
VWA 7.59
D21S11 9.14
D151656 5.47
D2S441 4.92
D8S1179 5.39
D19S433 6.91
D22S1045 8.22
D10S1248 2.60

1 These percentages are used as stutter filters in NGM_Detect_Stutter.txt

Extra peaks: 3’ A nucleotide addition definition

Addition of 3' A

Many DNA polymerases can catalyze the addition of a single nucleotide

nucleotide (predominantly adenosine) to the 3" ends of double-stranded PCR products (Clark,
1988; Magnuson et al., 1996). This nontemplate addition results in a PCR product that
is one nucleotide longer than the actual target sequence. The PCR product with the

extra nucleotide is referred to as the “+A” form.
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3’ A observations

The efficiency of +A addition is related to the particular sequence of the DNA at the 3’
end of the PCR product.

The NGM Detect " kit includes two main design features that promote maximum +A
addition:

¢ The primer sequences have been optimized to encourage +A addition.

¢ The PCR chemistry allows complete +A addition with a short final incubation at
60°C for 5 minutes.

This final extension step gives the DNA polymerase additional time to complete +A
addition to all double-stranded PCR products. Figure 27 shows examples of
incomplete and normal +A addition. Final extension incubation for longer than the
recommended time can result in double +A addition, in which two nontemplate
adenosine residues are added to the PCR product. Double +A addition can cause
"shoulders" on the right side of main allele peaks.

0 minutes final extension

[7] Mark Sample for Deletion

TS (551 ] [Tt ] [Dizss
0 - w0 22 260
so00
co00
P
2000
Bl
] Mark Sample for Deletion
[D195433 | [D2251045 |

8000
S0
a0
2000

5 minutes final extension

[ Mark Sample for Deletion

165539 | [DT8551 ] [HoT ] D539
100 140 180 220 20
5000
sa00
00
2000
] 13
(] Mark Sample for Deletion
[LEETEIED ] [DAssaEs | [2EE 1
100 a0 180 220 260
a000
6000
a0
2000

Figure 27 Omitting the final extension step results in shoulders on main allele peaks due
to incomplete +A nucleotide addition. Examples shown are the smaller amplicons of VIC™
and SID™ dye channel data from a 3500xL Genetic Analyzer using the NGM Detect™ kit.

If the amount of input DNA is greater than recommended concentration,
"shouldering" of allele peaks can be observed. Amplification of excess input DNA can
also result in off-scale data and lowered IQCL peak heights. In this situation, the IQCL
may also exhibit some shouldering due to incomplete +A nucleotide addition.
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Artifact definition

Artifacts and anomalies are seen in all molecular biological systems. Artifacts are
typically reproducible. Anomalies are non-reproducible, intermittent occurrences that
are not observed consistently in a system (for example, spikes and baseline noise).

Dye artifact observation

Due to improvements in PCR primer manufacturing processes, the incidence of
artifacts has been greatly reduced in the NGM Detect " kit. Internal population studies
show that kit electropherograms are free of reproducible dye artifacts in the kit read
region of 64-458 nt. Two exceptions are as follows:

e Alow level 113-117 nt dye artifact in the VIC" dye channel that has been
detected below commonly used analytical thresholds.

* A low level ~66 nt dye artifact in the TED"" dye channel. This artifact was
approximately 40-80 RFU in our studies. The peak height observed may vary
depending on the sensitivity of individual CE instruments.

Figure 28 shows the low baseline-level fluorescence that is observed in a typical
negative control PCR. However, it is important to consider noise and other
amplification-related artifacts when interpreting data.
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Figure 28 Examples of fluorescence background in data produced on a 3500xL Genetic
Analyzer (Y-axis scale 0 to 200 RFU).

Some small PCR artifacts were occasionally observed with the human male 007 DNA

provided as the control DNA in the NGM Detect ~ kit. The most prominent and
consistent artifacts were:

* A 170-bp artifact in the SID™" channel

* Two artifacts consistent with the size of a -2 and -3 repeat unit stutter for allele 14
of D25441

In all cases, the peak heights of the artifacts were typically 1% or less than peak
heights of the nearest true allele. If higher amounts of DNA (that is, 1 ng or more) are
amplified, or if a lower PAT is used, then the peak heights could theoretically exceed
the analytical threshold. The peak height of the artifacts appeared to be proportional
to the amount of input 007 DNA in the PCR.
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“The basic characteristics of a genetic marker should be determined and
documented.” (SWGDAM, December 2016)

This section describes basic characteristics of the 16 autosomal STR loci, Y indel locus,
and sex-determining marker (Amelogenin), that are amplified with the NGM Detect -
kit. Most of these loci have been extensively characterized by other laboratories.

The primers for the Amelogenin locus flank a 6-nucleotide deletion in intron 1 of the
X homolog. Amplification generates 108-nt and 114-nt products from the X and Y
chromosomes, respectively. The primers for the Y indel flank a region in the q arm of
the Y chromosome (Yq11.221). Depending on the haplotype of the sample, the
amplification generates either a 91-nt or a 96-nt product. (Sizes are the actual
nucleotide size according to sequencing results, including 3" A nucleotide addition,
and size may not correspond exactly to allele mobility observed on capillary
electrophoresis platforms.) Except for D2251045, a trinucleotide STR, the remaining
loci are tetranucleotide short tandem repeat (STR) loci. The length differences among
alleles of a particular locus are caused by differences in the number of repeat units.

™

We have sequenced all the alleles in the NGM Detect ~ kit Allelic Ladder, including
microvariants. In addition, other groups in the scientific community have sequenced
alleles at some of these loci (Nakahori ef al., 1991; Puers et al., 1993; Moller et al., 1994;
Barber et al., 1995; Moller and Brinkmann, 1995; Barber et al., 1996; Barber and Parkin,
1996; Brinkmann et al., 1998; Momhinweg ef al., 1998; Watson ef al., 1998). Among the
various sources of sequence data on the loci, there is consensus on the repeat patterns
and structure of the STRs.

The Centre d'Etude du Polymorphisme Humain (CEPH) has collected DNA from
families of Utah Mormon, French Venezuelan, and Amish descent. These DNA sets
have been extensively studied all over the world and are routinely used to
characterize the mode of inheritance of various DNA loci. Each family set contains
three generations, generally including four grandparents, two parents, and several
offspring. Consequently, the CEPH family DNA sets are ideal for studying inheritance
patterns (Begovich et al., 1992).

The NGM Detect " kit loci have been mapped, and the chromosomal locations have
been published (Nakahori et al., 1991; Edwards et al., 1992; Kimpton et al., 1992; Mills
et al., 1992; Sharma and Litt, 1992; Li et al., 1993; Straub et al., 1993; Barber and Parkin,
1996; and Lareu, et al., 1996).

Two sets of STR loci in the NGM Detect " kit are located on the same chromosomes.
vWA and D125391 are located approximately 6.3 million bp apart on the p arm of
chromosome 12; D251338 and D25441 are located approximately 150 million bp apart
on opposite arms of chromosome 2. Linkage disequilibrium analysis was conducted
on the genotype results from 1,034 individuals of three ethnic groups (350 African
American, 349 Caucasian, and 335 Hispanic). STR locus genotype results from the
population study were analyzed using the Linkage Disequilibrium module of
GenePop software version 4.0.10 (Raymond and Rousset, 1995; Rousset, 2008). See
Table 7 for results.
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The relatively high probability values indicate that there is no statistically significant
linkage disequilibrium found between the pairs of loci that are located on the same
chromosome.

An independent analysis of data from the same collection of population samples
(Budowle, et al., 2010) also concluded that the 15 STR loci that are shared between the
NGM"™ and NGM SElect " kits were independent at the population level (note that the
SE33 locus was not part of this analysis). Therefore, to calculate the rarity of a profile
for comparison to single-source and mixture samples, the frequencies of all loci
including vWA and D125391 could be multiplied. However, the analysis of the CEPH
pedigree families demonstrated a degree of linkage between vWA and D125391 that
does not support the assumption of independence for kinship analysis.

Table 7 GenePop software LD Result (p-value for pairwise analysis of loci)

Chromosome African- . . .
Locus Chromosome Nuclear American | Caucasian | Hispanic
map position!"! | Coordinates!"! = =
_ (n =350) (n=293)
(million bp) (n = 350)
vWA 12p13.31 5.9
0.86 0.29 0.27
D125391 12p13.2 12.2
D2S441 2pl4 68
0.1 0.32 0.19
D251338 2935 218

[ STR locus mapping data was obtained from the NCBI Map Viewer http://www.ncbi.nlm.nih.gov/projects/
mapview/map_search.cgi?taxid=9606 or the UCSC Genome Browser (http://genome.ucsc.edu/). GenePop LD
analysis probability results (p values) greater than 0.05 were considered to indicate that linkage
disequilibrium between the loci within the population tested was not statistically significant.

Species specificity

SWGDAM
Guideline 3.2

Nonhuman
studies

“The ability to detect genetic information from non-targeted species (e.g., detection of
microbial DNA in a human assay) should be determined. The detection of genetic
information from non-targeted species does not necessarily invalidate the use of the
assay, but may help define the limits of the assay.” (SWGDAM, December 2016)

The NGM Detect " kit provides the required specificity for detecting human alleles.
Species specificity testing was performed to ensure that there is no cross-reactivity
with nonhuman DNA that may be present in forensic casework samples.

The following species were tested (in the specified amounts) using standard PCR and
capillary electrophoresis conditions for the NGM Detect "~ kit kit:

e Primates: gorilla, chimpanzee, orangutan, and cynomolgous (macaque) (0.5 ng
each)

* Non-primates: mouse, dog, sheep, pig, rabbit, cat, horse, hamster, rat, chicken,
and cow (5.0 ng each)

* Microorganisms: Candida albicans, Staphylococcus aureus, Escherichia coli, Neisseria
gonorrhoeae, Bacillus subtilis, and Lactobacillus rhamnosus (pooled genomic DNAs,
with approximately 50,000 copies of DNA from each species, per reaction)
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Results were evaluated for the presence of any amplified peaks that would indicate
cross reactivity of the NGM Detect ~ kit with any of these non-human species.

Figure 29 shows select electropherogram results from the species specificity tests. The
chimpanzee, gorilla (data not shown), orangutan (data not shown), and macaque
(data not shown) DNA samples produced partial profiles in the 70-400 nucleotide
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Figure 29 Representative electropherograms for some species tested in a species
specificity study. Data produced on a 3500xL Genetic Analyzer.

Table 8 shows the most significant cross-reactive peaks that were observed among
non-human, non-primate, genomic DNAs (that is, peaks over a 175 RFU Peak
Amplitude Threshold on the 3500xL Genetic Analyzer). Peaks were observed for dog,
horse, and rabbit. Most peaks did not fall into human STR locus bins or marker
ranges, and would therefore not be confused with human STR alleles. This data
shows that the likelihood of obtaining an allelic profile consistent with that from a
human sample, from non-primates or microorganisms, is low.
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Table 8 Observed cross-reactive peaks for non-human, non-primate animals.

Species Dye channel Size Peak height
401 bp 1,294 RFU
Dog ° 407 bp 1,046 RFU
Y 366 bp 289 RFU
Horse R 104 bp 915 RFU
Rabbit P 260 bp 389 RFU

“The ability to obtain reliable results from a range of DNA quantities, to include the
upper and lower limits of the assay, should be evaluated.” (SWGDAM, December
2016)

The recommended amount of input DNA for the NGM Detect " kit is 0.5 ng for

30 cycles of amplification based on real-time PCR quantification, such as with the
Quantifiler™ Trio DNA Quantification Kit or the Quantifiler HP DNA Quantification
Kit. To determine the optimum input DNA, perform studies according to the
quantification kit that you use.

If the sample contains degraded or inhibited DNA, amplification of a higher amount
of DNA may be beneficial. In Figure 30, DNA Control 007 was serially diluted from
0.5-0.008 ng. Full profiles (35 PCR products) were consistently obtained at 0.125 ng,
but occasional partial profiles resulted at lower concentrations.
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Figure 30 Electropherograms for amplifications using 500, 250, 125, 63, 32, 16, and 8 pg
of DNA Control 007. Electrophoresis was performed on a 3500xL Genetic Analyzer. Note
that as the DNA input is serially diluted by 2-fold, the Y-axis scale is also adjusted, as
needed, to accommodate lower peak heights.

Stability

SV\_IG DAM “The ability to obtain results from DNA recovered from biological samples deposited

guideline 3.4 on various substrates and subjected to various environmental and chemical insults
should be evaluated. In most instances, assessment of the effects of these factors on
new forensic DNA procedures is not required. However, if substrates and/or
environmental and/or chemical insults could potentially affect the analytical process,
then the process should be evaluated to determine the effects of such factors.”
(SWGDAM, December 2016)

NGM Detect™ PCR Amplification Kit User Guide 93



7

"V
el
Zaxd
n O

tability

Degraded DNA

94

hapter 6 Experiments and results

As the average size of degraded DNA approaches the size of the target sequence, the
amount of PCR product that is generated is reduced, because of the reduced number
of intact templates in the size range required for amplification. Degraded DNA was
prepared to examine the potential for differential amplification of loci. Approximately
10 pg of high molecular weight DNA was sonicated and subjected to digestion with
0.25 U/pL of DNase I for various lengths of time (from ~5-10 minutes) to produce a
range (low, medium, and high) of degradation levels (Bender et al., 2004). The DNA
was examined by agarose gel analysis to determine the average size of the DNA
fragments at each time point. Amplification of 0.5 ng of degraded DNA using the
NGM Detect " kit was performed. As the DNA became progressively degraded, the
loci failed to amplify robustly in order of decreasing size. Preferential amplification
was not observed.
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Figure 31 Amplification of a single donor DNA sample sonicated and incubated with
0.25 U/uL of DNase | for various lengths of time (from ~5-10 minutes).
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Heme compounds have been identified as PCR inhibitors in DNA samples that are
extracted from bloodstains (DeFranchis ef al., 1988; Alkane et al., 1994). It is believed
that the inhibitor is co-extracted and co-purified with the DNA and then interferes
with PCR by inhibiting polymerase activity. To examine the effects of hematin on the
performance of the NGM Detect ~ kit, 0.5 ng of DNA Control 007 was amplified in the
presence of increasing concentrations of hematin for 30 cycles of amplification
(Figure 32). The final concentrations of hematin that is used in the reaction were 0,

450, 575, and 700 pM (Table 9).

220 280 E )

0

[7] Mark Sample for Deletion

20 450

3000

2000

| i e |

NGM Detect kit
No inhibitor

220 B am an

£

[ Mark Sample for Deletion

20 60

3000

2000

ol

NGM Detect kit
575 uM Hematin

] Mark Sample for Deletion

20 50

3000

2000

1000

NGM SElect kit
No inhibitor

220 260 00 N

E

[ Mark Sample for Deletion

a2 450

3000

200

1000

NGM SElect kit
575 uM Hematin

Figure 32 Electropherograms for the NGM Detect” kit and the NGM SElect™ kit show the
improved performance of the NGM Detect” kit in the presence of hematin compared with
previous AmpFESTR"™ kits. The same set of inhibited samples was analyzed with the

NGM Detect” kit and the NGM SElect” kit for 30 cycles of amplification.

Table 9 NGM Detect™ kit performance in simulated hematin inhibition (N = 5).

. . Average number of alleles Minimum,
Hematin concentration 1l .
detected maximum
0 uM 35 35,35
450 uM 35 35,35
575 pM 12.4 12,13
700 pM 0 0,0

[0 Only those peaks >175 RFU were counted. A complete profile with DNA Control 007 yields 35 peaks using the

NGM Detect™ kit.
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Effect of Traces of humic acid may inhibit the PCR amplification of DNA evidence that is
inhibitors: humic collected from soil. Amplification of 0.5 ng of DNA Control 007 in the presence of

increasing amounts of humic acid was performed using the NGM Detect " kit for

acid e ) ) . . .
30 cycles of amplification (Figure 33). The final concentrations of humic acid tested in
the reactions were 0, 140, 250 and 400 ng/uL (Table 10).
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Figure 33 Electropherograms for the NGM Detect” kit and the NGM SElect™ kit show the
improved performance of the NGM Detect” kit in the presence of humic acid compared
with previous AmpFESTR™ kits. The same set of inhibited samples was analyzed with the
NGM Detect” kit and the NGM SElect™ kit for 30 cycles of amplification.
Table 10 NGM Detect™ kit performance in simulated humic inhibition (N = 5).
Humic acid concentration Number of alleles detected!"! Minimum,
maximum
0 ng/pL 35 35,35
140 ng/pL 35 35, 35
250 ng/pL 26 26,26
400 ng/pL 1 1,1
(1 Only those peaks »175 RFU were counted. A complete profile with DNA Control 007 yields 35 peaks using the
NGM Detect™ kit.
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“The ability to obtain reliable results from mixed source samples should be
determined.” (SWGDAM, December 2016)

Evidence samples may contain DNA from more than one individual. The possibility
of multiple contributors should be considered when interpreting the results. Perform
studies to determine a minimum peak height threshold to avoid typing when
stochastic effects are likely to interfere with accurate interpretation of mixtures.

Evidence samples that contain body fluids and/or tissues originating from more than
one individual are an important category of forensic casework.

It is essential to ensure that the DNA typing system is able to detect DNA mixtures.
Typically, mixed samples can be distinguished from single-source samples by:
* The presence of more than two alleles at one or more loci

¢ The presence of a peak at a stutter position that is significantly greater in
percentage than typically observed in a single-source sample

¢ Significantly imbalanced alleles for a heterozygous genotype

The peak height ratio is defined as the height of the lower peak (in RFU) divided by
the height of the higher peak (in RFU), expressed as a percentage.

If an unusually low peak height ratio is observed for one locus, and there are no other
indications that the sample is a mixture, reamplify and reanalyze the sample to
determine if the imbalance is reproducible. Possible causes of imbalance at a locus are:

* Degraded DNA

* Presence of inhibitors

¢ Extremely low amounts of input DNA

* A mutation in one of the primer binding sites

* Presence of an allele containing a rare sequence that does not amplify as
efficiently as the other allele
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Median, minimum, and maximum peak height ratios observed for alleles in the
NGM Detect " kit loci in unmixed human population database samples (N=60) are
shown in Figure 34. The donor samples that were used are listed in “Population
samples used in these studies” on page 102.
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Figure 34 Heterozygote ratios for 0.5 ng of input DNA. The distribution of intra-locus peak
height ratio is expressed as a percentage, by locus (low peak height allele divided by high
peak height allele). Boxes show the middle 50% or interquartile range (IQR). Box halves
below and above median show the second and third quartile, respectively. “"Whiskers™
indicate 1.5 IQR from the upper and lower margins of the IQR. Black dots are outlier data
points more than 1.5 IQR from the median (N=60).

A sample containing DNA from two sources can comprise (at a single locus) any of
the seven genotype combinations (see below).

* Heterozygote + heterozygote, no overlapping alleles (four peaks)
* Heterozygote + heterozygote, one overlapping allele (three peaks)
* Heterozygote + heterozygote, two overlapping alleles (two peaks)
¢ Heterozygote + homozygote, no overlapping alleles (three peaks)
* Heterozygote + homozygote, overlapping allele (two peaks)
* Homozygote + homozygote, no overlapping alleles (two peaks)
¢ Homozygote + homozygote, overlapping allele (one peak)
Specific genotype combinations and input DNA ratios of the samples contained in a

mixture determine whether or not it is possible to resolve the genotypes of the major
and minor components at a single locus.

The ability to obtain and compare quantitative values for the different allele peak
heights on Applied Biosystems " instruments provides additional valuable data to aid
in resolving mixed genotypes.

Ultimately, the likelihood that any sample is a mixture must be determined by the
analyst in the context of each particular case, including the information provided from
known reference samples.
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Note: Peak detection is a complex process that involves the STR chemistry, capillary
electrophoresis conditions, and the data analysis software. Contact HID Support for a
Technical Note with additional information on detecting peaks in electropherograms.

Mixtures of two DNA samples were examined at various ratios (0:1, 1:1, 1:3, 1:7, 1:15,
1:30, 30:1, 15:1, 7:1, 3:1 and 1:0 M:F ratios). The total amount of genomic input DNA
mixed at each ratio was 0.5 ng. The samples were amplified in a GeneAmp"* PCR
System 9700, then electrophoresed and detected using a 3500xL Genetic Analyzer.

The results of the mixed DNA samples are shown in Figure 35. The male 007 and
female 9947a were mixed according to the ratios indicated. The minor component
allele calls at non-overlapping loci are highlighted. Detection of full profiles for the
minor contributor was possible at ratios of 7:1 (0.438 ng of 007 and 0.063 ng of 9947a)
and 1:7 (0.063 ng of 007 and 0.438 ng of 9947a, with 2/3 replicates giving full profiles
of the 007 minor contributor). 15:1, 30:1, 1:30, and 1:15 ratios resulted in partial
profiles for the minor component. The genotypes of these samples are shown in
Table 11.

Table 12 shows mixture sample compositions and STR allele counts from
NGM Detect " assays.
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Figure 35 Amplification of DNA mixtures at various ratios. Panels show
electropherograms for 1:0 (male 007 DNA only), 1:1 mixture, 7:1 mixture, 1:7 mixture, and
0:1 (female 9947a DNA only).

Note: The data in this figure are from the original formulation of the NGM Detect™ kit.

Table 11 Genotypes of mixed DNA samples
Note: The data in this table are from the original validation study of the NGM Detect" kit.
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Locus Male 007 alleles Female 9947a alleles
IQCSs — — — —
D251338 20 23 19 23
SE33 17 25.2 19 29.2
lQCL — — — —
D165539 9 10 M 12
D18S51 12 15 15 19
THO1 7 9.3 8 9.3
D125391 18 19 18 20
D351358 15 16 14 15
FGA 24 26 23 24

Y indel 2 — — -
Amelogenin X Y X -
VWA 14 16 17 18
D21S11 28 31 30 —
D1S1656 13 16 18.3 —
D2S441 14 15 10 14
D8S1179 12 13 13 —
D19S433 14 15 14 15
D2251045 " 16 " 14
D10S1248 12 15 13 15

Table 12 Mixture sample compositions and STR allele counts from NGM Detect™
assays

Note: The data in this table are from the original validation study of the NGM Detect™ kit.

Number of unique alleles in
ng per reaction non-stutter positions per
Ratio (M:F) contributor!"
Male 007 Female TotalDNA | Male 007 Female
9947a 9947a
1:0 0.500 0.00 0.5 16.00 0.00
1:1 0.250 0.250 0.5 16.00 13.00
1:3 0.125 0.375 0.5 16.00 13.00
1:7 0.063 0.438 0.5 15.67 13.00
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Number of unique alleles in
ng per reaction non-stutter positions per

Male 007 Female TotalDNA | Male 007 Female

9947a 9947a

1:15 0.031 0.469 0.5 12.33 13.00
1:30 0.016 0.484 0.5 8.00 13.00
30:1 0.484 0.016 0.5 16.00 8.67
15:1 0.469 0.031 0.5 16.00 11.67
7:1 0.438 0.063 0.5 16.00 13.00
3:1 0.375 0.125 0.5 16.00 13.00
0:1 0.000 0.500 0.5 0.00 13.00

1 Mixture sample compositions and STR allele counts from NGM Detect™ assays. Average number of unique,
distinct alleles (that is, alleles neither present in the other contributor genotype nor located in a stutter
position) obtained in 3 replicate reactions per mixture sample. Full profiles of unique alleles in 007 and 9947a
DNAs were 16 and 13, respectively.

“The distribution of genetic markers in populations should be determined in relevant
population groups.” (SWGDAM, December 2016)

To interpret the significance of a match between genetically typed samples, you must
know the population distribution of alleles at each locus in question. If the genotype
of the relevant evidence sample is:

¢ Different from the genotype of the reference sample for a suspect, then the
suspect is excluded as the donor of the biological evidence that was tested. An
exclusion is independent of the frequency of the two genotypes in the population.

¢ The same as the genotype of the reference sample for a suspect, then the suspect
is included as a possible source of the evidence sample.

The probability that another, unrelated individual would also match the evidence
sample is estimated by the frequency of that genotype in the relevant populations.

The NGM Detect " kit contains loci for which extensive population data are available.
For additional information on the loci shared between many of the AmpF¢STR™ kits,
see the population data and additional studies section of the AmpF{STR™ NGM
SElect™ PCR Amplification Kit Kit User Guide (Pub. No. 4458841) and the AmpF{STR"™

Identifiler Plus PCR Amplification Kit User Guide (Pub. No. 4440211).
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Note: The data in this section are from the original validation study of the
NGM Detect " kit.

The NGM Detect " kit has high genotypic concordance (>99.5%) to the NGM SElect "
kit and by extension to the GlobalFiler " kit. (All STR markers in the NGM SElect " kit
are included in the GlobalFiler " kit with both the GlobalFiler" and NGM SElect " kits
sharing the same primers for common loci.) Therefore, the existing population data
from the GlobalFiler " kit was used, as applicable, to generate the population data that
is provided in this section. Whole blood samples, provided by the Interstate Blood
Bank (Memphis, Tennessee) and Boca Biolistics (Coconut Creek, Florida), were
collected in the United States (with no geographical preference) from randomly
selected individuals of known ethnicities. Ethnicities of sample donors were:

¢ African-American—330 samples
¢ Asian—153 samples
¢ Caucasian—343 samples

¢ Hispanic—368 samples
DNA was extracted using a 6100 Nucleic Acid Prep Station.

In addition to the alleles that we observed and recorded in our databases, other alleles
have been published or reported to us by other laboratories (see the STRBase at
www.cstl.nist.gov/div831/strbase).

In the validation study of the original NGM Detect " kit formulation, a concordance
population study with 1,165 in-house samples identified two samples that were
discordant because of allele dropout or severe allele imbalance in the NGM Detect
assay. The samples were characterized and degenerate oligos were added to the SE33
(2 oligos) and D851179 (1 oligo) markers in the final stages of development. The
resulting concordance between the NGM SElect " kit and the NGM Detect " kit was
greater than 99.5%.

In the validation study of the updated NGM Detect " kit formulation, we used the
new primer set with 1,092 individuals from the same donor population. We observed
100% concordance between the new primer set and the original primer set at the THO1
locus.

The Py value is the probability that two individuals selected at random will have an
identical genotype (Sensabaugh, 1982).
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Table 13 shows the Autosomal STR allele frequencies at NGM Detect " kit loci by

population group.

Table 14 shows the Y-specific allele frequencies by population group for NGM Detect "
kit Y indel locus. The Y-specific allele frequencies were not included in the probability
of identity calculation.

Table 15 shows the Probability of identity (Py) values of the NGM Detect "~ kit loci
individually and combined.

Table 13 Autosomal allele frequencies by population group for NGM Detect™ kit STR
loci. (*=Alleles not detected or not detected in significant quantities)

Allele Apr::rci?::n Asian (n=153) US[::;:;]S fan U'S['r:i;:sa]"ic
(n=330)
D251338
0 ) ) ) )
" ; ; ; ;
1 ; ; ; ;
13 0.15* * 0.15* *
14 . . 0.15* *
15 0.30* * 0.15*% *
16 5.3 1.63 4.08 3.8
17 10 14.05 18.37 17.8
18 4.85 13.07 8.31 6.52
19 16.21 16.67 14.14 17.53
20 10.45 8.82 15.74 13.86
21 11.97 2.94 2.92 3.67
22 12.42 5.88 1.75 6.52
23 9.24 18.3 10.06 14.27
2% 8.79 1.1 10.2 8.83
25 6.97 5.88 12.1 5.43
26 2.58 * 1.6 1.49
27 0.76 0.33* 0.29* 0.14*
28 * 0.98* * 0.14*
29 * 0.33* * *
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Population data

African

Allele A[r::;;coa]n Asian (n=153) U.S.[::;;.:;]sian U.S[hzgsbpaa]nic
SE33

3.7 x x x x
42 x x x x

5 x x x x

6 x * x x
6.3 * * 0.15* *

7 x x x x
8 x x x x
8.2 * * * *

9 x x x x
97 x x x x
10 x x x x
10.2 x x x x
1 x x x x
11.2 0.76 * * 0.14*
12 0.15* 0.33* 0.44* 0.14*
12.1 * * 0.15* *
12.2 0.30* * 0.15* 0.14*
13 1.36 * 0.87 1.22
13.2 0.45* * * 0.14*
14 3.33 * 3.64 1.77
14.2 0.15* * * 0.82
14.3 * * 0.15* *
15 4.24 1.31* 3.64 4.89
15.2 0.15* * 0.15* 0.14*
153 x x x x
16 6.97 3.59 5.39 5.57
16.2 0.30* * * 0.27*
16.3 * * * 0.14*
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Population data

Allele Apr;::'cii:n Asian (n=153) | Y5 '[::;gfia" U'S’[h':gsép;]"ic
(n=330)

17 7.73 5.23 6.56 8.7
17.2 0.15* * * *
17.3 * * 0.15* *

18 10.76 4.9 7.87 10.05
18.2 0.15* * * 0.27*

19 15 9.48 8.31 8.15
19.2 0.30* * 0.29* *
19.3 * * 0.29* *

20 9.55 6.86 5.25 4.48
20.2 0.91 0.33* 0.87 0.82

21 5.76 6.21 2.04 3.12
211 x x x x
21.2 0.91 1.63 1.17 1.09

22 1.97 2.61 0.58* 1.09
22.2 1.36 2.29 3.35 2.31

23 0.30* * * *
23.2 0.61* 2.61 2.62 2.85
23.3 * * * 0.14*

24 0.30* 0.33* 0.15* 0.14*
24.2 1.67 6.54 4.52 2.31

o5 x x x x
25.2 2.42 7.19 3.79 3.12

26 0.15* * * 0.27*
26.2 5.61 7.52 4.52 6.39

27 x x x x
27.2 5.91 3.59 6.85 7.07

8 x x x x
28.2 3.94 7.84 7.73 6.25

29 * * * *
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Population data

Allele

African
American
(n=330)

Asian (n=153)

U.S. Caucasian
(n=343)

U.S. Hispanic
(n=368)

29.2

2.58

8.5

7.87

5.84

30

*

*

*

*

30.2

1.21

7.52

4.66

3.8

31

0.14*

31.2

1.06

1.63

2.77

2.31

32

0.44%*

32.2

0.76

1.31*

1.6

2.04

33

0.29*

0.41*

33.2

0.45*

0.33*

0.15*

0.54*

34

0.29*

0.41%*

34.2

0.15*

0.27*

35

0.15*

35.2

36

0.15*

36.2

37

37.2

38

38.2

39

39.2

40

41

42

43

D16S539

4

5

0.14*
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Population data

African . . .
Allele American Asian (n=153) U.S.[:f:;.:;]smn U.S[.nH;sbpsa]mc
(n=330) - -

7 * * * *

8 3.33 * 1.46 2.04

9 21.67 31.05 12.68 10.19
93 * * * *

10 11.52 14.05 4.08 15.76

11 30 20.59 32.22 31.79
12 19.09 21.57 30.9 24.18
121 * * * *

13 13.03 11.44 16.76 14.4
13.3 * * * *

14 1.36 1.31* 1.75 1.22

5 * * 0.15* 0.27*
16 * * * *

D18S51

6 * * * *

7 * * * *

8

9 * * * 0.14*
92 * * * *

10 0.15* * 1.17 0.68
10.2 0.15* * * *

11 0.45* 1.31* 0.87 1.22
’|’|2 * * * *
12 6.21 5.56 15.01 10.46
123 * * * *
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Population data

African . . .
Allele American Asian (n=153) U.S.[:f;zglsmn U.S[.nH:;sbpsa]mc
(n=330) - -
13 3.94 17.32 11.95 11.41
131 * * * *
13.2 0.30* * * *
14 5.91 22.88 17.64 16.3
14.2 0.45* * * 0.14*
15 16.52 16.99 15.31 12.23
15.2 * * * 0.14*
16 18.18 12.42 11.95 12.91
162 * * * *
17 16.36 6.54 10.79 17.39
172 * * * *
18 14.09 4.9 8.31 7.74
181 * * * *
19 9.7 5.23 4.08 3.53
20 4.7 1.96 1.31 1.9
20.2 0.15* * * *
21 1.82 1.96 1.02 2.17
2’]2 * * * *
22 0.61* 0.98* 0.29* 0.68
222 * * * *
23 0.30* 0.98* 0.29* 0.54*
24 * 0.65* * 0.27*
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Population data

African . . .
Allele American Asian (n=153) U.S.[:f:;.:;]smn U.S[.nH;sbpsa]mc
(n=330) - -

25 * * * 0.14*
26 * 0.33* * *

27 * * * *

28 * * * *

THO1

3 * * * *

4 * * * *

5 0.45* * 0.15* *

6 15.45 13.07 21.72 2717

7 37.42 26.14 17.64 32.74

8 20.61 3.59 11.37 8.7

9 16.06 51.63 17.06 12.77
9.3 8.33 4.25 31.2 17.12
10 1.52 1.31* 0.87 1.49
103 * * * *

1" * * * *

’|2 * * * *

13 * * * *
143 * * * *

D12S391

13 * * * 0.14*

14 * * * 0.14*

15 7.58 2.61 4.37 4.08

16 5.15 0.98* 3.35 5.03

109
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Population data

Allele AEE;%;n Asian (n=153) | Y5 '[::;gfia" U'S’[h':gsép;]"ic
17 16.52 8.17 10.35 7.34
17.1 0.45* * * 0.27*
17.3 0.61* . 1.9 1.22
18 24.55 28.43 16.18 19.7
181 ) ) ) )
18.3 1.21 * 2.19 2.17
19 13.94 23.86 12.54 18.75
19.1 0.61* * * *
19.3 0.30* * 0.58* 1.22
20 11.52 16.99 9.77 17.12
0.1 ; ; ; ;
20.3 * * 0.15* *
21 7.27 10.78 13.56 8.7
213 0.15*% * 0.15*% *
22 5 3.59 10.79 6.79
23 3.64 3.27 8.16 3.67
24 0.61* 0.98* 3.64 1.9
243 ; ; ; ;
25 0.61* 0.33* 1.9 1.36
26 * * 0.29* 0.27*
27 * * 0.15* 0.14*
D351358
8 ) ) ) )
9 0.30* * * 0.14*
10 ; ; ; ;
1 * * 0.29* *
12 0.15* 0.33* * 0.14*
13 0.61* * 0.15*% 0.41*
14 9.09 2.61 15.16 9.1
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Population data

African . . .
Allele American Asian (n=153) U.S.[:f:;.:;]smn U.S[.nH;sbpsa]mc
(n=330) - -

15 28.18 49.02 27.26 34.65
15.2 0.30* * * *

16 32.42 21.9 24.34 26.9

17 22.27 19.61 19.68 17.93
172 * * * *

18 6.06 6.54 11.66 9.92

19 0.61* * 1.46 0.82

20 * * * *
201 * * * *

2‘| * * * *

FGA

13 * * * *

14 * * * *

15 * * * *

16 * 0.33* 0.15* *

16.1 0.30* * * *

17 * 0.33* 0.15* *

18 0.91 3.27 1.02 0.68
18.2 0.61* * * *

19 6.97 4.25 5.69 7.61
19.2 0.45* * * *

20 6.82 3.92 14.87 8.7
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Population data

African . . .
Allele American Asian (n=153) U.S.[:f;zglsmn U.S[.nH:;sbpsa]mc
(n=330) - -
20.2 0.30* * 0.44* 0.27*
21 11.67 13.07 18.22 13.45
21.2 0.15* 0.33* 0.29* *
22 17.27 14.38 19.24 14.4
22.2 0.15* * 0.87 0.54*
223 * * * *
23 17.27 2712 14.87 12.91
231 * * * *
23.2 * 0.65* 0.44%* 0.41*
23.3 0.30* * * *
24 18.94 18.3 14.43 15.62
24.2 * 0.33* * *
25 9.55 9.8 6.71 13.72
253 * * * *
26 4.09 3.27 1.9 7.07
261 * * * *
27 2.58 0.65* 0.58* 3.12
28 1.21 * 0.15* 0.95
282 * * * *
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Population data

Allele

African
American
(n=330)

Asian (n=153)

U.S. Caucasian
(n=343)

U.S. Hispanic
(n=368)

29

*

0.41%*

29.2

*

*

30

0.15*

0.14*

30.2

0.15*

31

31.2

32

32.2

33.2

34.2

41.2

42.2

43.2

44.2

45.2

46.2

47.2

48.2

49.2

50.2

51.2

52.2

VWA

10

1

0.45%*

0.14*

12

0.27*

13

0.91

0.15*

0.14*

14

7.27

23.53

8.75

6.52

15

20.91

1.63

12.24

9.78
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Population data

114

Allele

African
American
(n=330)

Asian (n=153)

U.S. Caucasian
(n=343)

U.S. Hispanic
(n=368)

15.2

*

16

27.58

15.36

22.3

30.57

17

19.85

29.74

27.41

27.17

18

13.79

19.61

17.78

18.07

18.2

19

6.52

9.15

10.06

6.39

20

1.97

0.98*

1.31

0.82

21

0.61*

22

23

0.15*

24

25

D21S11

23

23.2

24

24.2

24.3

25

25.2

253

26

0.30*

0.58*

0.41*

26.2

27

5.91

2.62

1.49

27.1

27.2

28

4.9

11.41

28.1

28.2

0.65*

0.14*
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Population data

African . . .
Allele American Asian (n=153) U.S.[:f;zglsmn U.S[.nH:;sbpsa]mc
(n=330) - -

29 15.61 26.8 23.76 21.06
29.2 * * 0.15* *

29.3 0.15* * 0.15* *

30 20.76 30.72 23.18 2717
301 * * * *

30.2 1.67 0.65* 2.77 1.77

31 8.79 9.48 6.85 5.16
31.2 4.55 3.92 8.89 11.14
31.3 * 0.33* * *

32 1.36 2.61 2.33 1.36
32.2 7.12 14.38 9.62 12.5
323 * * * *

33 0.91 0.98* * 0.14*
331 * * * *

33.2 3.18 4.58 1.9 5.3

34 0.15* * * *
34.2 * * 0.44%* 0.14*

35 3.64 * * 0.27*
351 * * * *

36 0.76 * * 0.14*
361 * * * *
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Population data

Allele Aﬁ::fii:n Asian (n=153) | Y5 '[::;gfia" U'S’[h':gsép;]"ic
(n=330)
36.2 * * * *
37 . . . .
37.9 . . . .
38 * * * 0.14*
382 . . . .
39 . . . .
D151656
8 . . . .
9 0.15* * * 0.14*
10 1.36 * 0.29* 0.41
1 5.3 3.59 6.27 3.94
12 8.48 4.25 15.74 9.38
13 11.06 13.73 7 7.07
13.3 . . . .
14 25 6.21 6.27 11.28
14.3 0.91 * 0.29* 0.27*
15 16.97 20.26 15.31 15.49
15.3 1.82 * 8.75 2.99
16 10 31.05 9.33 15.08
16.3 7.27 0.45* 4.96 5.16
17 2.73 14.05 4.96 6.79
17.1 * * 0.29* *
17.3 5.76 3.59 12.68 15.76
18 0.45* 0.33* 0.29* 0.82
18.3 1.82 1.63 5.98 4.48
19 0.15% * * *
19.3 0.61* 0.33* 1.6 0.68
20 * 0.33* * *
20.3 0.15% * * *
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Population data

Allele Aﬁ::fii:n Asian (n=153) | Y5 '[::;gfia" U'S’[h':gsép;]"ic
(n=330)

21 x x x x

213 x x x x
D2S441

7 x x x x

8 0.15* * * *

9 * * 0.58* 0.14*
9.1 * 2.94 * *
10 9.09 20.59 19.83 30.3
1 35.61 36.27 33.09 31.93
11.3 2.88 2.61 5.1 4.62
12 20.45 20.92 4.08 3.8
12.3 0.15* * 0.29* 0.41*
13 3.48 6.21 3.35 1.9
13.3 x x x x
14 26.21 9.8 28.86 23.1
143 x x x x
15 1.97 0.65* 4.37 3.4
16 * * 0.44* 0.41*
17 x x x x
18 x x x x

D8S1179

4 x x x x

5 x x x x

6 x x x x

7 x x x x

8 0.30* * 2.04 0.68

9 0.30* * 1.31 0.27*
10 3.33 9.8 10.5 9.51
102 * * * *
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Population data

Allele Aﬁ::fii:n Asian (n=153) | Y5 '[::;gfia" U'S’[h':gsép;]"ic
(n=330)
1 5.61 9.48 6.71 5.03
12 11.36 13.4 15.16 12.5
193 . . . .
13 18.18 2418 33.24 33.15
13.3 . . . .

14 35.91 15.69 18.8 23.23

15 18.03 22.22 9.04 11.41
e . . . .

16 5.91 4.25 2.77 3.53
17 1.06 0.98* 0.44* 0.68
18 . . . .
19 . . . .
20 . . . .

D195433

e . . . .
£ . . . .

i . . . .
6.2 . . . .

7 . . . .

8 . . . .

9 0.30* 0.33* * *
9.9 . . . .
10 1.21 * 0.15* 0.41*

10.2 0.15% * * *

1 9.85 * * 1.63

1.2 0.30* * * 0.27*
12 10.45 4.58 7.29 8.42
12.1 * * 0.15*% *

12.2 3.94 0.33* 0.15% 1.49
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Population data

Allele AEE;%;n Asian (n=153) | Y5 '[::;gfia" U'S’[h':gsép;]"ic
13 27.88 28.1 27.26 18.48
131 * * * *
13.2 5.3 2.61 1.6 6.93
14 18.94 23.2 35.13 30.71
14.2 5.3 9.48 2.04 4.62
14.3 * * * *
15 6.67 7.52 16.18 13.04
15.2 4.39 20.26 3.5 6.79
16 1.52 0.33* 5.69 4.08
16.2 3.18 2.61 0.29* 2.17
17 * * 0.29* 0.54*
17.2 0.61* 0.65* 0.15* 0.41*
18 * * 0.15* *
18.2 * * * *
19 * * * *
192 * * * *
20.2 * * * *
D2251045

6 * * * *

7 * * * *

8 0.61* * * *

9 * * * *
10 4.09 * 0.44* 0.68
1" 14.7 15.36 13.85 7.61
12 6.21 0.33* 0.58* 0.95
13 0.30* 0.33* 1.02 1.09
14 7.88 0.33* 3.35 2.04
15 23.33 33.66 36.3 43.48
16 20.3 23.86 36.3 34.65
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Population data

Allele Aﬁ::fii:n Asian (n=153) | Y5 '[::;gfia" U'S’[h':gsép;]"ic
(n=330)
17 20.45 2418 7.58 8.42
18 2.12 1.96 0.58* 0.95
19 . . . .
20 * * * 0.14*
o1 . . . .
D1051248

7 0.15% * * *

8 * * * 0.14*
9 0.15* * * 0.14*
10 * 0.33* * 0.14*
1 3.64 * 0.58* 0.27*
12 14.09 10.78 3.5 4.48
13 22.88 36.93 29.45 25.95
14 27.88 22.55 29.74 36.14
15 18.48 22.55 19.39 22.69
16 10.15 5.23 13.41 7.74
17 2.27 1.63 3.64 2.31
18 0.30* * 0.29* *
19 . . . .
20 . . . .

Table 14 Y-specific frequencies by population group for the NGM Detect™ kit Y indel
locus. (*=Alleles not detected or not detected in significant quantities)

Mol | AMEEDAMORGAN | b nns) | caucasian |Y5:Hispan
(n=233)
Y indel
1 1.22 67.69 * 0.55*
2 98.78 32.31 100 99.45

NGM Detect™ PCR Amplification Kit User Guide




Probability of
paternity
exclusion
observation

NGM Detect™ PCR Amplification Kit User Guide

Chapter 6 Experiments and results

KKK A
%

A

Population data

Table 15 Probability of identity (P)) values for the NGM Detect™ kit STR loci

Locus Aﬁgﬁi:n Asian (n = 153) U'S['nc:gg?ian Ufn Eigbpg]nic
(n =330)

D10S1248 0.0693 0.1045 0.0943 0.1131
D125391 0.0377 0.0664 0.0231 0.0318
D165539 0.0727 0.0915 0.1043 0.0809
D18S51 0.0322 0.0402 0.0311 0.0281
D195433 0.0388 0.0663 0.0862 0.0484
D151656 0.034 0.0564 0.0223 0.0247
D21511 0.0453 0.0671 0.052 0.0487

D2251045 0.0559 0.1073 0.1309 0.1604
D251338 0.0225 0.0337 0.0316 0.0316
D2S441 0.103 0.0961 0.0976 0.1079
D351358 0.0984 0.1689 0.0749 0.0949
D851179 0.0762 0.0527 0.0631 0.0661

FGA 0.0322 0.0555 0.0384 0.0282
SE33 0.0118 0.0139 0.0085 0.0081
THO1 0.0949 0.175 0.0801 0.0902
VWA 0.0622 0.084 0.065 0.0926

Combined 7.96 x 10722 2.25 x 10717 2.29 x 10721 3.12 x 10-21

Allele frequencies, observed heterozygosity (Ho), expected heterozygosity (He), Match
Probability (MP), and p-value of each locus was calculated using a software program
developed by Ge (Li et al., 2013) and shown in the following table.

Departures from Hardy-Weinberg Equilibrium (HWE) expectations of each locus were
derived using Arlequin (Excoffier ef al., 2010). After Bonferroni correction (Weir, 1990),
(p-value = 0.05/21 = 0.0024), no departures from HWE were observed at any locus.
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Table 16 Allele frequencies, observed heterozygosity (Ho), expected heterozygosity (He), Match probability (MP), and p-value of STR loci

African American Asian U.S. Caucasian U.S. Hispanic
Marker
Ho | He | MPp | P ' Ho | He | mMp | P | Ho | He | M | Fr | Ho | He | mp | Fr
Y-indel - - 0.976 - - - 0.556 - - - 1 - - - 1 -
D35S1358 | 0.772 | 0.762 | 0.094 | 0.902 | 0.686 | 0.682 | 0.151 | 0.012 | 0.753 | 0.786 | 0.079 | 0.698 | 0.698 | 0.758 | 0.098 | 0.291
vWA 0.752 | 0.798 | 0.068 | 0.116 | 0.829 | 0.784 | 0.08 | 0.309 | 0.841 | 0.807 | 0.064 | 0.621 | 0.842 | 0.782 | 0.08 | 0.463
D16S539 | 0.772 | 0.797 | 0.071 0.026 0.8 0.764 | 0.092 | 0.457 | 0.801 0.749 | 0.103 | 0.047 0.77 0.774 | 0.084 | 0.835
D851179 | 0.782 | 0.793 | 0.068 | 0.662 | 0.814 | 0.828 | 0.052 | 0.795 | 0.793 | 0.797 | 0.065 | 0.122 | 0.755 | 0.802 | 0.064 | 0.518
D21S11 | 0.861 | 0.849 | 0.039 | 0.553 0.8 0.791 | 0.069 | 0.667 | 0.873 | 0.837 | 0.046 | 0.385 | 0.827 | 0.839 | 0.044 | 0.315
D18S51 | 0.931 | 0.868 | 0.031 | 0.324 | 0.829 | 0.853 | 0.038 | 0.572 | 0.873 | 0.872 | 0.03 | 0.962 | 0.849 | 0.87 | 0.031 | 0.945
D2S441 0.772 | 0.756 | 0.099 | 0.421 0.714 | 0.746 | 0.101 0.238 | 0.757 | 0.766 0.09 0.077 | 0.791 | 0.763 | 0.094 | 0.611
D19S433 | 0.812 | 0.825 | 0.051 0.663 | 0.714 | 0.802 | 0.064 0.13 0.785 | 0.774 | 0.083 | 0.859 0.82 0.834 | 0.046 | 0.446
THO1 0.762 | 0.747 | 0.102 | 0.418 | 0.614 | 0.656 | 0.171 | 0.381 | 0.753 | 0.783 | 0.081 | 0.326 | 0.77 | 0.767 | 0.091 | 0.845
FGA 0.782 | 0.866 | 0.033 | 0.082 0.9 0.841 | 0.044 | 0.24 | 0.829 | 0.857 | 0.037 | 0.337 | 0.842 | 0.882 | 0.025 | 0.127
D2251045| 0.842 | 0.822 | 0.055 | 0.062 | 0.743 | 0.742 | 0.112 | 0.966 | 0.705 | 0.714 | 0.131 | 0.026 | 0.698 | 0.672 | 0.162 | 0.064
SE33 0.96 | 0.929 | 0.009 | 0.776 | 0.943 | 0.936 | 0.008 | 0.526 | 0.968 | 0.947 | 0.005 | 0.532 | 0.921 | 0.941 | 0.007 | 0.597
D10S1248 | 0.792 | 0.789 | 0.075 | 0.823 | 0.757 | 0.764 | 0.091 0.928 | 0.785 | 0.769 0.09 0.63 0.691 | 0.724 | 0.124 | 0.336
D1S1656 | 0.921 | 0.863 | 0.033 | 0.351 | 0.757 | 0.818 | 0.056 | 0.043 | 0.912 | 0.899 | 0.019 | 0.55 | 0.871 | 0.896 | 0.02 | 0.048
D12S391 | 0.861 | 0.864 | 0.032 | 0.19 | 0.771 | 0.808 | 0.063 | 0.65 | 0.904 | 0.896 | 0.02 0.45 | 0.842 | 0.874 | 0.028 | 0.071
D251338 | 0.911 | 0.894 | 0.02 | 0.763 | 0.871 | 0.872 | 0.03 | 0.356 |0.88 0.878 |0.027 |0.23 0.906 |0.877 |0.027 |0.929
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Chapter 6 Experiments and results

KKK A
%

A

Population data

The following table shows the Probability of paternity exclusion (PE) values of the NGM Detect " kit STR loci
individually and combined.

The PE value is the probability, averaged over all possible mother-child pairs, that a random alleged father will

™

be excluded from paternity after DNA typing using the NGM Detect ~ kit STR loci (Chakraborty, Stivers, and

Zhong, 1996).

Table 17 Probability of paternity exclusion values for the NGM Detect™ kit STR loci

Locus Afric[in=A3m38;ican Asian (n = 153) Caucasian [n = 343) Hispanic (n = 368)
D10S1248 0.6623 0.5353 0.5649 0.4644
D125391 0.7401 0.631 0.8032 0.6588
D16S539 0.5548 0.6063 0.5915 0.5623

D18S51 0.7892 0.656 0.7557 0.7121
D19S433 0.6332 0.5238 0.5135 0.6431
D15S1656 0.7462 0.5703 0.8032 0.7338
D21S11 0.728 0.6063 0.7264 0.7013
D2251045 0.7038 0.4795 0.4507 0.397
D251338 0.814 0.7463 0.7498 0.7392
D2S441 0.5228 0.5353 0.4986 0.5051
D351358 0.4918 0.3976 0.5338 0.4689
D851179 0.599 0.6063 0.6187 0.5381
FGA 0.728 0.8397 0.6632 0.7175

SE33 0.8639 0.88 0.9231 0.8781

THO1 0.5124 0.3424 0.5036 0.5381

VWA 0.6103 0.6186 0.6576 0.6276

PEi 7.8605 x 10~7 1.3136 x 1077 1.2071 x 1078 7.3910 x 10-8
Combined 0.9999999921 0.9999998686 0.9999999879 0.9999999261
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Troubleshooting

Observation

Possible cause

Recommended action

Faint or no signal from both the
DNA Control 007 and the DNA
test samples at all loci,
including the 1QC markers

The incorrect volume of Master
Mix or Primer Set was used.

Use the correct volume of Master Mix or
Primer Set.

The DNA Polymerase was not
activated.

Repeat the amplification with an initial hold at
95°C for 1 minute.

The Master Mix was not
vortexed thoroughly before
aliquoting.

Vortex the Master Mix thoroughly.

The Primer Set was exposed to
too much light.

Replace the Primer Set and store it protected
from light.

Evaporation.

Ensure that the plate is properly sealed with
film and that a compression pad was used with
the GeneAmp™ PCR System 9700. (A
compression pad should not be used with other
validated thermal cyclers.)

The thermal cycler
malfunctioned.

See the thermal cycler user manual and check
the instrument calibration.

Incorrect thermal cycler
conditions were used.

Use correct thermal cycler conditions.

A MicroAmp™ base was used
with a tray/retainer set and
tubes in GeneAmp™ PCR
System 9700.

Remove the MicroAmp™ base.

The tubes or plate were not
seated tightly in the thermal
cycler during amplification.

Push the tubes or plate firmly into the block
after first cycle.

The wrong PCR reaction tubes
or plate were used.

Use MicroAmp™ Reaction Tubes with Caps or
the MicroAmp™ Optical 96-well Reaction Plate
for the GeneAmp™ PCR System 9700 or Veriti™
Thermal Cycler.

Insufficient PCR product was
electrokinetically injected.

Use correct genetic analyzer settings.

Degraded formamide was used.

Check the storage of formamide. Do not thaw
and refreeze multiple times. Try Hi-Di™
Formamide.

Positive signal from DNA
Control 007 but partial or no
signal from DNA test samples
when 1QC peaks are present
and balanced

The quantity of test DNA
sample is below the assay
sensitivity.

Quantify DNA and (when possible) add 500 pg
of DNA. For low concentration samples, add up
to 15 pL of the DNA sample to the reaction mix.
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Appendix A Troubleshooting
Population data

Observation

Possible cause

Recommended action

Positive signal from DNA
Control 007 but partial or no
signal from DNA test samples
when |QC peaks are present
and balanced

The test sample DNA is
severely degraded.

Use the Quantifiler™ HP DNA Quantification Kit
or the Quantifiler™ Trio DNA Quantification Kit
to evaluate sample quality during the
quantification step. If DNA is degraded,
reamplify with an increased amount of DNA or
consider using the Precision ID GlobalFiler™
NGS STR Panel.

The test sample was diluted in
the wrong buffer (for example,
a TE buffer with an incorrect
EDTA concentration).

Redilute DNA using low-TE buffer (with 0.1 mM
EDTA).

Positive signal from DNA
Control 007 but partial or no
signal from DNA test samples
when |QC peaks are present
and unbalanced

The test sample contains a high
concentration of PCR inhibitor
(for example, heme
compounds, certain dyes).

Quantify the DNA, then use the minimum
necessary volume of test sample DNA.

Wash the sample in a Centricon™-100
centrifugal filter unit.

The test sample was diluted in
the wrong buffer (for example,
a TE buffer with an incorrect
EDTA concentration).

Redilute DNA using low-TE buffer (with 0.1 mM
EDTAJ.

Positive signal from DNA
Control 007 and elevated signal
from DNA test samples when
IQC peaks are present and
unbalanced

The quantity of the test sample
DNA is in excess of
recommended input amount,
which can cause loss of balance
in 1QC peaks.

Quantify DNA, then use 500 pg.

More than two alleles present
at a locus

Exogenous DNA is present in
the sample.

Use appropriate techniques to avoid
introducing foreign DNA during laboratory
handling.

Stutter product (-1 repeat unit
position) was amplified.

Ensure that stutter filters are applied.

Stutter filters apply to sample
input amounts equal or greater
than 250 pg. Samples well
below the recommended input
amount may exhibit stutters
values exceeding the filters due
to the stochastic effects of the
PCR.

Increase the sample input above 250 pg, if
possible. (Note, the optimum sample input is
500 pg.)

The test sample contained
mixed DNA.

If a mixed profile is not expected, check that
laboratory protocols relating to cleanliness are
followed.

Incomplete 3" A base addition
(n-1 nt position) occured.

Include the final extension step of 60°C for
5 minutes in the PCR.

Remove amplified plate from storage (thaw if
necessary) and place on thermal cycler at 60°C
for 15 minutes.

Check the quantity of the original sample DNA
to ensure input is less than 750 pg per
reaction. Adjust input as necessary during re-
amplification.
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Appendix A Troubleshooting
Population data

Observation

Possible cause

Recommended action

More than two alleles present
at a locus

If the total amount of DNA in the reaction
exceeds 1 ng, adjust the final extension time to
15 minutes to minimize incomplete 3" A base
addition.

The signal exceeds the dynamic
range of the instrument and is
causing signal "pull-up” into
adjacent channels.

Check that you are using the recommended
number of PCR cycles. Repeat PCR
amplification using reduced input DNA amount,
or interpret the off-scale data according to
your laboratory procedure.

Check that you are using the recommended
injection conditions on the instrument.

Poor spectral separation
occurred.

Perform a spectral calibration.

Confirm that Filter Set J6-T modules are
installed and used for analysis.

Too much DNA was present in
the reaction.

Use the recommended amount of template
DNA: 500 pg for 30 PCR cycles.

The double-stranded DNA was
not completely denatured.

Use the recommended amount of Hi-Di™
Formamide and heat the sample plate at 95°C
for 3 minutes.

Poor peak height balance

Incorrect thermal cycler
conditions were used.

Use correct thermal cycler conditions.

Some but not all loci visible on
electropherogram of DNA Test
Samples

The PCR reaction volume you
used is lower than the volume
required for the amplification.

Use the correct PCR reaction volume: 25 pL

STR profiles contain many off-
scale alleles

DNA quantification was not
performed or not accurate.

Ensure that DNA quantification is accurate.
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Materials required but not supplied

Unless otherwise indicated, all materials are available through thermofisher.com.
MLS: Fisher Scientific (fisherscientific.com) or other major laboratory supplier.

STR kit required materials

Item Source
NGM Detect™ PCR Amplification Kit, 200 reactions A31832
Sample preparation required materials

Item Source
GeneScan" 600 LIZ™ Size Standard v2.0, 2 x 200 pL 4408399
IMPORTANT! Do not use GeneScan' 350 ROX", GeneScan " 500 ROX", or
GeneScan™ 500 LIZ™ Size Standards with this kit.
Low-TE buffer (10 mM Tris, 0.1 mM EDTA, pH 8.0) Teknova T0223

or see “Prepare low-TE buffer” on

page 19.
Hi-Di" Formamide, 25-mL 4311320
Thermal cycler required materials
ProFlex” PCR System
Item Source
ProFlex" 96-well PCR System 4484075
ProFlex” 2 x 96-well PCR System 4484076
ProFlex™ 3 x 32-Well PCR System 4484073
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Appendix B Materials required but not supplied
Genetic analyzer required materials

Veriti" Thermal Cycler

Item Source
Veriti" 96-Well Thermal Cycler 4479071
(Optional) Tabletop centrifuge with 96-Well Plate Adapters MLS
GeneAmp" PCR System 9700

Item Source
GeneAmp" PCR System 9700, 96-Well Silver N8050001
GeneAmp" PCR System 9700, 96-Well Gold-Plated 4314878
Silver 96-Well Sample Block N8050251
Gold-Plated 96-Well Block 4314443
Genetic analyzer required materials
3500 Series Genetic Analyzer

Item Source
3500 Series Data Collection Software 3.1 Upgrade (RUO) A2628711)
3500 Series Data Collection Software 3.1 (RUO) 44751831
HID Updater 3500 Data Collection Software v2 4480670
Anode buffer container (ABC]) 4393927
Cathode buffer container (CBC] 4408256
POP-4" Polymer (960 samples) for 3500/3500xL Genetic Analyzers 4393710
POP-4" Polymer (384 samples) for 3500/3500xL Genetic Analyzers 4393715
DS-37 Matrix Standard Kit (Dye Set J6-T) A31234
Conditioning reagent 4393718
8-Capillary array, 36 cm for 3500 Genetic Analyzers 4404683
24-Capillary array, 36 cm for 3500xL Genetic Analyzers 4404687
96-well retainer & base set (Standard) 3500/3500xL Genetic Analyzers 4410228
8-Tube retainer & base set (Standard) for 3500/3500xL Genetic Analyzers 4410231
8-Strip Septa for 3500/3500xL Genetic Analyzers 4410701
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Appendix B Materials required but not supplied
Analysis software required materials

Item Source
96-Well Septa for 3500/3500xL Genetic Analyzers 4612614
Septa Cathode Buffer Container, 3500 series 4410715
1" Contact your Thermo Fisher Scientific HID representative.
3130 Series Genetic Analyzer required materials
Item Source
3130 Data Collection Software v4 4475105
3130x{ Data Collection Software-v4 4475126
3130/3730 Data Collection Software-v4 6-Dye Module v1 4478404
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3130/3130x( Genetic Analyzer 16-Capillary Array, 36 cm 4315931
POP-4" Polymer for the 3130/3130x/ Genetic Analyzer 4352755
Running Buffer, 10X 402824
DS-37 Matrix Standard Kit (Dye Set J6-T) A31234
MicroAmp™ Optical 96-Well Reaction Plate N8010560
Analysis software required materials
GeneMappe r In addition to the GeneMapperm ID-X Software listed in the following table, a v.1.5.2
/D-X Software patch is required. The patch enables full functionality of the data quality assessment

v1.5.2 patch

tools when using the NGM Detect PCR Amplification Kit.

The patch is available for free download at thermofisher.com/us/en/home/
technical-resources/software-downloads/genemapper-id-x-software.html.

GeneMapper™ /D-X Software

Item Source
GeneMapper " /D-X Software v1.5 Full Installation A27884
GeneMapper" /D-X Software v1.5 Client Installation A27886
GeneMapper" /D-X Software v1.4 Full Installation 4479707
GeneMapper " /D-XSoftware v1.4 Client Installation 4479711
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Appendix B Materials required but not supplied

Miscellaneous required materials

Miscellaneous required materials

Plates and tubes

Item Source
MicroAmp™ 96-Well Tray N8010541
MicroAmp™ Reaction Tube with Cap, 0.2 mL N8010540
MicroAmp™ 8-Tube Strip, 0.2 mL N8010580
MicroAmp" Optical 8-Cap Strips 4323032
MicroAmp" 96-Well Tray/Retainer Set 403081
MicroAmp™ 96-Well Base N8010531
MicroAmp™ Clear Adhesive Film 4306311
MicroAmp™ Optical Adhesive Film 4311971
MicroAmp" Optical 96-Well Reaction Plate N8010560
Laboratory supplies

Item Source
Various procedures
Aerosol resistant pipette tips MLS!
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon™ MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Vortex MLS

(7 Major laboratory supplier

130

NGM Detect™ PCR Amplification Kit User Guide



PCR work areas

Work area setupand labdesign .............. ... ... .o ool 131
PCR setup work area materials ........... ... ... .. o i il 131
Amplified DNA workarea .......... ...t 132

Work area setup and lab design

Many resources are available for the appropriate design of a PCR laboratory. If you
are using this kit for:

* Forensic DNA testing, see "Forensic Laboratories: Handbook for Facility
Planning, Design, Construction, and Moving", National Institute of Justice, 1998

e Parentage DNA testing, see the "Guidance for Standards for Parentage
Relationship Testing Laboratories", American Association of Blood Banks, 7th
edition, 2004

The sensitivity of this kit (and other PCR-based tests) enables amplification of minute
quantities of DNA, necessitating precautions to avoid contamination of samples yet to
be amplified (Kwok and Higuchi, 1989).

Process samples carefully to prevent contamination by human DNA. Wear gloves at
all times and change them frequently. Close sample tubes when not in use. Limit
aerosol dispersal by handling sample tubes and reagents carefully.

Note: We do not intend these references for laboratory design to constitute all
precautions and care necessary for using PCR technology.

PCR setup work area materials

IMPORTANT! Do not remove these items from the PCR Setup Work Area.

¢ Calculator

* Gloves, disposable

* Marker pen, permanent
* Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate nuclease-free tube
(for master mix preparation)

* Microcentrifuge tube rack
* Pipette tips, sterile, disposable hydrophobic filter-plugged
¢ Pipettors
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Appendix C PCR work areas
Amplified DNA work area

* Tube decapper, autoclavable

e Vortex

Amplified DNA work area

IMPORTANT! Place the thermal cyclers in the Amplified DNA Work
Area.

Use only the validated thermal cyclers listed in “Instruments and software
compatibility” on page 15.
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Safety

A WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

- Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

- Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, and so on). To obtain SDSs, see the “Documentation
and Support” section in this document.
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Chemical safety
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Appendix D Safety
Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below. Consult the relevant SDS
for specific precautions and instructions:

- Read and understand the Safety Data Sheets (SDSs) provided by the

chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

- Minimize contact with chemicals. Wear appropriate personal protective

equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

- Minimize the inhalation of chemicals. Do not leave chemical containers open.

Use only with adequate ventilation (for example, fume hood).

- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow

the manufacturer's cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

- Ensure use of primary and secondary waste containers. (A primary waste

container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

- After emptying a waste container, seal it with the cap provided.
- Characterize (by analysis if necessary) the waste generated by the particular

applications, reagents, and substrates used in your laboratory.

- Ensure that the waste is stored, transferred, transported, and disposed of

according to all local, state/provincial, and/or national regulations.

- IMPORTANT! Radioactive or biohazardous materials may require special

handling, and disposal limitations may apply.
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Appendix D Safety
Biological hazard safety

Biological hazard safety

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Conduct all work in properly equipped facilities
with the appropriate safety equipment (for example, physical containment
devices). Safety equipment can also include items for personal protection, such
as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety
glasses, or goggles. Individuals should be trained according to applicable
regulatory and company/ institution requirements before working with
potentially biohazardous materials. Follow all applicable local, state/provincial,
and/or national regulations. The following references provide general
guidelines when handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological
and Biomedical Laboratories (BMBL), 5th Edition, HHS Publication No. (CDC)
21-1112, Revised December 2009; found at:
www.cdc.gov/biosafety/publications/bmbl5/BMBL.pdf

- World Health Organization, Laboratory Biosafety Manual, 3rd Edition,
WHO/CDS/CSR/LYO/2004.11; found at:

www.who.int/cst/resources/publications/biosafety/Biosafety7.pdf
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Documentation and support

Related documentation

Document title Pub. No.
STR kits
NGM Detect” PCR Amplification Kit - PCR Amplification and CE Quick Reference 100044088
NGM Detect” PCR Amplification Kit - PCR Setup Quick Reference 100044087

Technical Note: Updated NGM Detect” PCR Amplification Kit: Validation and Comparative Study —

Note: Go to thermofisher.com/document-connect/document-connect.html?url=https://
assets.thermofisher.com/TFS-Assets/GSD/Technical-Notes/ngm-detect-results-tech-note.pdf to
open the Technical Note.

Quantification kits

Quantifiler” HP and Quantifiler" Trio DNA Quantification Kits User Guide 4485355

Thermal cyclers

ProFlex" PCR System User Guide MAN0007697
Veriti" Thermal Cycler User Guide 4375799
GeneAmp" PCR System 9700 Base Module User Manual 4303481

3500 Series Genetic Analyzer

3500/3500xL Genetic Analyzer with 3500 Series Data Collection Software v1 User Guide 4401661
3500/3500xL. Genetic Analyzer with 3500 Series Data Collection Software v2 User Guide 4476988
HID Updater 3500 Data Collection Software v2.0 User Bulletin NA
3500/3500xL Genetic Analyzer with 3500 Series Data Collection Software 3.1 User Guide 100031809
3500 Series Data Collection Software v3 User Bulletin: New Features and HID Validation MANO0010812
Summary

3500 Series Data Collection Software v3.1 User Bulletin: New Features and HID Validation MANO0014110
Summary

3130x{Series Genetic Analyzer

3130/3130x! Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide 4352716
3130/3130x!( Genetic Analyzers Using Data Collection Software v3.0 User Bulletin 4363787
3130/3130x! Genetic Analyzers Getting Started Guide 4352715
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Documentation and support
Related documentation

Document title Pub. No.
3130/3130x! Genetic Analyzers Quick Reference Card 4362825
3130/3130x!( Genetic Analyzers AB Navigator Software Administrator Guide 4359472
GeneMapper" /D-XSoftware all versions
GeneMapper" ID-X Software Bin Overlap User Bulletin 100029546
GeneMapper" /D-XSoftware v1.0
GeneMapper" ID-X Software v1.0 Getting Started Guide— Basic Features 4375574
GeneMapper" ID-X Software v1.0 Quick Reference— Basic Features 4375670
GeneMapper" ID-X Software v1.0 Installation Guide 4476603
GeneMapper" ID-X Software v1.0 Administrator Guide 4376327
GeneMapper" ID-X Software v1.0 Reference Guide 4375671
GeneMapper ™ /D-XSoftware v1.1
GeneMapper" ID-X Software v1.1 Getting Started Guide— Mixture Analysis Tool 4396773
GeneMapper" /D-X Software v1.2
GeneMapper" ID-X Software v1.2 Verification Experiments and Installation Procedures User 4462639
Bulletin
GeneMapper" ID-X Software v1.2 Quick Reference— Mixture Analysis Tool 4426482
GeneMapper" ID-X Software v1.2 Reference Guide 4426481
GeneMapper™ /D-XSoftware v1.3
GeneMapper" ID-X Software v1.3 Verification Experiments and Installation Procedures User 4470483
Bulletin
GeneMapper" /D-XSoftware v1.4
GeneMapper'" ID-X Software v1.4 New Features and Installation Procedures User Bulletin 4477684
GeneMapper™ /D-X Software v1.5
GeneMapper" ID-X Software v1.5 New Features and Verification User Bulletin 100031708
GeneMapper" ID-X Software v1.5 Getting Started Guide— Basic Features 100031701
GeneMapper" ID-X Software v1.5 Quick Reference— Basic Features 100031702
GeneMapper" ID-X Software v1.5 Getting Started Guide— Mixture Analysis Tool 100031704
GeneMapper" ID-X Software v1.5 Quick Reference— Mixture Analysis Tool 100031705
GeneMapper" ID-X Software v1.5 Installation Guide 100031706
GeneMapper" ID-X Software v1.5 Administrator Guide 100031703
GeneMapper" ID-X Software v1.5 Reference Guide 100031707
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Documentation and support
Customer and technical support

Customer and technical support

For support:

¢ In North America—Send an email to HIDTechSupport@thermofisher.com, or
call 888-821-4443 option 1.

* Outside North America—Contact your local support office.
For the latest services and support information for all locations, go to
thermofisher.com/support to obtain the following information.

* Worldwide contact telephone numbers

* Product support

¢ Order and web support

e Safety Data Sheets (SDSs; also known as MSDSs)

Additional product documentation, including user guides and Certificates of
Analysis, are available by contacting Customer Support.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale at
www.thermofisher.com/us/en/home/global/terms-and-conditions.html. If you have
any questions, please contact Life Technologies at www.thermofisher.com/support.
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